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ПАСПОРТ ПРАКТИКУМА МДК 02.01 ПРОФЕССИОНАЛЬНОГО 

МОДУЛЯ 

1.1 Область применения программы 

Практикум составлен в соответствии с рабочей программой по 

дисциплине, отражает ее содержание и структуру и предполагает как базовый, 

так и повышенный уровень в обучении студентов. Является частью 

профессионального модуля ПМ.02, основной профессиональной 

образовательной программы в соответствии с ФГОС по специальности СПО 

42.02.01 Реклама. Может быть использован в дополнительном 

профессиональном образовании и профессиональной подготовке по 

специальности, является  общепрофессиональным, устанавливающим базовые 

знания для освоения специальных дисциплин, формирующим и развивающим 

образное мышление и индивидуальные способности будущих специалистов в 

области рекламного производства, помочь обучающимся обобщить и 

систематизировать практические навыки, закрепить теоретические знания.  

1.2. Место практикума учебной дисциплины в структуре основной 

профессиональной образовательной программы  

Практикум междисциплинарного курса (МДК 02.02) «Проектная 

компьютерная графика и мультимедиа» принадлежит к профессиональному 

модулю ПМ.02. Задания и упражнения имеют практическую направленность и 

проводятся в тесной взаимосвязи с другими общепрофессиональными 

дисциплинами государственного образовательного стандарта: «Выполнение 

рекламных проектов в материале», «Рекламная деятельность», «Техника и 

технология видеосъемки»  и т. д., а также ориентировано на получение 

студентами навыков и знаний по использованию передовых компьютерных 

технологий. Обучение включает в себя обучение компьютерным программам: 

Adobe InDesign – программа для верстки и дизайна 

Adobe Illustrator  располагая которыми можно решить любые задачи, связанные с 

графическим дизайном и версткой. 

 Adobe Photoshop, которая предназначена для любых работ, связанных с 

созданием и обработкой точечной (растровой) графики.  

Изучение материала ведётся в форме, доступной пониманию студентов, 

соблюдается единство терминологии в соответствии с действующими 

государственными стандартами. Выполнение практических заданий 

способствует формированию  и развитию у студентов нового творческого 

мышления и художественного воображения.  

1.3 Цели и задачи практикума – требования к результатам освоения 

дисциплины: Целью МДК.02.02 Проектная компьютерная графика и 

мультимедиа является всестороннее развитие и качественная профессиональная 

подготовка специалиста, владеющего необходимыми знаниями в области 

технологий и дизайна, креативно мыслящего,  способного осуществлять 

практическую деятельность в сфере применения проектной компьютерной 

графики и мультимедиа.  



 

Обеспечивает соответствующий уровень знаний проектной компьютерной 

графики и мультимедиа и умений для применения в рекламной деятельности. В 

программе даются знания об искусстве синтеза технологий и художественного 

содержания, о прикладных перспективах для нужд будущей профессии.  

Целью практикума «МДК.02.02. Проектная компьютерная графика и 

мультимедиа» является изучение основных аспектов применения 

компьютерных технологий и мультимедиа в дизайне рекламы, позволяющих 

грамотно ориентироваться в вопросах получения, обработки, интерпретации 

необходимой для рекламной деятельности информации и применения 

соответствующих приёмов с целью подготовки, содержания и художественного 

оформления решений при создании проектов рекламных модулей, оценки 

активности рекламной деятельности. 

Предлагаемый практикум является обобщением опыта работы 

составителя, специалистов  в области применения проектной компьютерной 

графики и мультимедиа.   

 С целью овладения указанным видом профессиональной деятельности и 

соответствующими профессиональными компетенциями обучающийся в ходе 

освоения профессионального модуля должен: 

иметь практический опыт:  

—  выбора и использования инструмента, оборудования и основных 

изобразительных средств и  материалов при исполнении рекламного продукта; 

— построения модели (макета, сценария) объекта с учетом выбранной 

технологии; 

— подготовки к производству рекламного продукта с учетом аспектов  

психологического воздействия рекламы, правового обеспечения рекламной 

деятельности и требований заказчиков;  
уметь: 

— использовать компьютерные технологии при создании печатного 

рекламного продукта; 

— использовать профессиональные пакеты программного обеспечения для 

обработки графики, аудио-, видео-, анимации; 

— использовать мультимедийные и web- технологии для разработки и 

внедрения рекламного продукта;  

— использовать ресурсы Интернета; 

— разрабатывать WEB-документы с использованием графических элементов; 

— использовать мультимедийные возможности программы Flash при создании 

WEB узла; 

— создавать озвученные анимации; 

— сохранять готовый мультимедийный продукт на современных 

накопительных устройствах. 
иметь практический опыт:  

— технические и программные средства для создания печатного рекламного 

продукта; 



 

—  технические и программные средства для компьютерной обработки 

графики, аудио-, видео-, анимации;  

—   технологию создания Интернет-рекламы; 

— аппаратное и программное обеспечение  

— назначение и возможности компьютерных сетей различных уровней; 

— структуру,   основные   информационные   ресурсы   и   технологии 

поиска         информации в сети Интернет; 

— принципы разработки Web документов; 

— устройства,    конвертирующие    аналоговые    сигналы,    полученные    из 

различных источников, в цифровую форму; 

— способы взаимодействия аппаратных устройств и программных продуктов в 

процессе преобразования; 

— программные   продукты,   используемые   для   захвата   и   преобразования 

аналоговых сигналов в цифровую форму; 

Характеристика сферы и объектов профессиональной деятельности 

студента, изучившего дисциплину МДК.02.02 Проектная компьютерная 

графика и мультимедиа  

- специалист может осуществлять аналитическую и организаторскую 

работу в сфере рекламных функций в условиях хозяйственной деятельности 

любых типов бизнес - субъектов; 

- специалист должен быть подготовлен к профессиональным аспектам 

работе по данной специализации в рекламных, маркетинговых и сбытовых 

службах предприятия 

Для процесса обучения предполагается использовать литературные 

источники, WEB-сайты, профессиональные  клипарты и любительские 

фотографии, опираться на наблюдения, знакомиться с разнообразными видами 

орнаментального и декоративного творчества.  

В целях оптимального усвоения учебного материала все практические 

работы, представленные в Практикуме, имеют однотипную структуру: 

формируются тема и цель занятия, предлагаются методические рекомендации, в 

которых в виде теоретического материала изложены важные моменты, на 

которые студенту необходимо обратить внимание при выполнении работы, 

также представлены примеры выполнения задания и описаны этапы выполнения 

работы.  

По окончании темы предлагается выполнить тренировочное задание. 

Такая структура Практикума способствует оптимальному усвоению материала 

как аудитории, так и самостоятельно. 

Структура практикума 

1. Каждое задание соответствует теме одному или нескольким разделам

программы по изучению курса. 

2. Материал занятия включает:

-  основные понятия; 

-  методические рекомендации по выполнению работы, которые необходимо 

изучить перед выполнением заданий; 



 

- основные приемы работы, описание последовательности команд для 

реализации основных задач. Все задания должны выполняться последова-

тельно, так как они расположены в порядке возрастания сложности; 

- этапы выполнения работы; 

-  упражнения и проекты для самостоятельного выполнения. 

Занятие проходит достаточно эффективно, если его продолжительность 

составляет 3 академических часа. В конце каждого практического занятия 

студенты должны получить результат (рисунок, изображение, коллаж  и т.д.) 

 В зависимости от темы и уровня подготовки студентов, в течение одного 

занятия можно рассмотреть не один, а два-три задания. 

Требования к системным ресурсам (не менее). 

-   Операционная система — Windows 95/98/NT 4.0/ 2000/ХР. 

-   Процессор — Pentium II/III. 

-   Оперативная память — 128 Мб или более. 

-   Свободное дисковое пространство — не менее 280 Мб. 

- Видеоадаптер, поддерживающий глубину цвета не менее 16 битов 

(рекомендуется 24-битовый), и разрешение 800х600 или выше. 

Практикум содержит два приложения, которые содержат задачники 

различного уровня сложности с основными заданиями по данному 

практикуму в электронном виде. 

Перечень практических и самостоятельных работ 

Наименование практической работы по 

разделам 

часы Наименование 

самостоятельной работы по 

разделам 

1 2 3 

Раздел 1. Основы создания и 

редактирования растровых изображений 

Практическая работа 1.1  

Знакомство с Photoshop.   

Интерфейс. Основные инструменты. 

4 Знакомство с прогр. 

Adobe Photoshop, изучение 

интерфейса, основных 

инструментов 

Практическая работа 1.2  

Выделение и трансформация. 

2 Выбор нужных 

инструментов, выделение 

области предложенным 

способом, трансформации 

Практическая работа 1.3 

Заливка и обводка. Свойства кистей. 

2 Рисование фигур 

различной сложности и 

выполнение заливки, 

использование режимов 

наложения. 

Практическая работа 1.4  

Просмотр изображения. Многослойные 

изображения. 

2 Увеличение масштаба 

просмотра изображения. 

Создание многослойных 



 

изображений. 

Практическая работа 1.5 

 Цвет в растровой графике. 

2 Создание «маски» 

используя знания по 

цветовой коррекции 

изображения. 

Практическая работа 1.6  

Реставрация изображений. 

4 Редактирование изобр, 

эффект «гламур» 

Итого по разделу: 16 16 

Раздел 2. Контуры. Фильтры. 

Операции по монтажу 

Практическая работа 2.1. Контурные слои. 2 Создание контура 

предложенного объекта 

Практическая работа 2.2. Группы фильтров. 2 Создание «волшебн. 

эффекта» изображения 

используя группы 

фильтров, кисти 

Практическая работа 2.3.  

Операции по монтажу изображений (коллаж) 

2 Из предложенных 

изображений создание 

единой композиции 

Итого по разделу: 6 6 

Раздел 3.  Подготовка и печать изображений 

Практическая работа 3.1. 

 Работа с текстом. Растрирование. Управление 

цветом.  

2 Превращение текста в 

постер 

Практическая работа 3.2.  

Подготовка и печать изображения. 

4 Создание и подготовка 

макета к печати 

Итого по разделу: 6 
6 

Раздел 4. Основы создания и 

редактирования векторных изображений. 

Практическая работа 4.1 

Знакомство с illustrator.  

Интерфейс. Контуры и фигуры. 

Операции с объектами. 

8 Выполнение зад-я на 

отработку знаний о 

программе Illustrator, 

интерфейса, работа с 

контурами и фигурами. 

Проделать операции с 

объектами 

Практическая работа 4.2  

Работа с цветом.  

Редактирование обводок.  

Группы и комбинированные контуры. 

12 Ознакомление с 

основными законами 

работы с цветом, 

редактированием обводок. 



 

Изучение объектов в 

документе, группы и 

комбинированные 

контуры. 

Итого по разделу: 20 20 

Раздел 5. Текст. Глобальное управление 

объектами. 

Практическая работа 5.1  

Создание и виды текстовых объектов. 

Атрибуты символов текста 

8 Выполнение работы по 

созданию текстовых 

объектов 

Практическая работа 5.2  

Представления объектов. 

Операции с кистями 

6 Редактирование 

представлений, работа с 

кистями 

Итого по разделу: 12 12 

Раздел 6. Растровые изображения и 

эффекты. Специальные объекты illustrator 

Практическая работа 6.1. 

Растровая графика.  

Форматы файлов и их параметры. 

Растеризация объектов. 

14 Работа по растеризации 

объектов 

Итого по разделу: 14 14 

Раздел 7. Печать. Оптимизация работы. 

Графика для web 

Практическая работа 7.1.  

Оптимизация рабочего пространства. 

Особенности графики для web 

14 Разработка дизайна для 

web-сайта 

Итого по разделу: 14 14 

При выполнении практических занятий студенты осваивают технические 

приемы графики, приобретают навыки работы,  знакомятся с основами 

разработки проектов, совершенствуют владение компьютерными 

технологиями. 

Результатом освоения является овладение обучающимися видом 
профессиональной деятельности разработка и создание дизайна 
рекламной продукции, в том числе профессиональными (ПК) и общими 
(ОК) компетенциями: 



 

Профессиональные  компетенции: 

Код Наименование результата обучения 

ПК 2.1 Выбирать и использовать инструмент, оборудование, основные 

изобразительные средства и материалы. 

ПК 2.2 Создавать модели (макеты, сценарии) объекта с учетом выбранной 

технологии. 

ПК 2.3 Исполнять оригиналы или отдельные элементы проекта в материале. 

Общекультурные компетенции: 

Код Наименование результата обучения 

ОК 1 Понимать сущность и социальную значимость своей будущей 

профессии, проявлять к ней устойчивый интерес 

ОК  2 Организовывать собственную деятельность, выбирать типовые 

методы и способы выполнения профессиональных задач, оценивать 

их эффективность и качество 

ОК  3 Принимать решения в стандартных и нестандартных ситуациях и 

нести за них ответственность 

ОК 4 Осуществлять поиск и использование информации, необходимой для 

эффективного выполнения профессиональных задач, 

профессионального и личностного развития 

ОК  5 Использовать информационно-коммуникационные технологии в 

профессиональной деятельности 

ОК  6 Работать в коллективе и в команде, эффективно общаться 

с коллегами, руководством, потребителями 

ОК  7 Брать на себя ответственность за работу членов команды 

(подчиненных), за результат выполнения заданий 

ОК  8 Самостоятельно определять задачи профессионального и 

личностного развития, заниматься самообразованием, осознанно 

планировать повышение квалификации 

ОК  9 Ориентироваться в условиях частой смены технологий 

в профессиональной деятельности 

ОК 11 Владеть основами предпринимательской деятельности и 

особенностями предпринимательства в профессиональной 

деятельности 

ОК 12 Обладать экологической, информационной и коммуникативной 

культурой, базовыми умениями общения на иностранном языке 



 

Раздел 1. ОСНОВЫ СОЗДАНИЯ И РЕДАКТИРОВАНИЯ РАСТРОВЫХ 

ИЗОБРАЖЕНИЙ 

Практическая работа 1.1  

Знакомство с Photoshop. Интерфейс. Основные инструменты 

Норма времени: 2 часа 

Цель работы: познакомиться с общими моментами работы в программе, 

с назначением  пунктов меню окна программы, краткое знакомство с 

инструментами,   научиться работать с панелями,  просматривать  изображения, 

информацию о документе, разрешение изображения.  

Студент должен знать: 

Команды открытия изображения. 

Элементы интерфейса программы. 

Назначение пунктов меню. 

Элементы палитры инструментов. Обзор палитр. 

Размеры изображения. 

Студент должен уметь: 

Открывать и сохранять изображения. 

Грамотно пользоваться палитрой инструментов и диалоговыми окнами. 

Использовать команды строки меню. 

Изменять размеры изображения. 

Задание:  Знакомство с программой Adobe Photoshop, изучение 

интерфейса, основных инструментов. 

Методические рекомендации по выполнению работы: Компьютерная 

графика - область информатики, изучающая методы и свойства и обработки 

изображений с помощью программно-аппаратных средств. 

Представление данных на компьютере в графическом виде впервые было 

реализовано в середине 50-х годов. Сначала, графика применялась в научно-

военных целях. Под видами компьютерной графики подразумевается способ 

хранения изображения на плоскости монитора. Машинная графика в настоящее 

время уже вполне сформировалась как наука. Существует аппаратное и 

программное обеспечение для получения разнообразных изображений - от 

простых чертежей до реалистичных образов естественных объектов. Машинная 

графика используется почти во всех научных и инженерных дисциплинах для 

наглядности восприятия и передачи информации. Знание её основ в наше время 

необходимо любому ученому или инженеру. Машинная графика властно 

вторгается в бизнес, медицину, рекламу, индустрию развлечений. Применение 

во время деловых совещаний демонстрационных слайдов, подготовленных 

методами машинной графики и другими средствам автоматизации конторского 

труда, считается нормой. В медицине становится обычным получение 

трехмерных изображений внутренних органов по данным компьютерных 

томографов. В наши дни телевидение и другие рекламные предприятия часто 

прибегают к услугам машинной графики и компьютерной мультипликации. 

Использование машинной графики в индустрии развлечений охватывает такие 

несхожие области как видеоигры и полнометражные художественные фильмы.  



 

В зависимости от способа формирования изображений компьютерную 

графику подразделяют:  

1. Растровая графика.

2. Векторная графика.

3. Трехмерная графика.

4. Фрактальная графика.

5. Символьная графика

Растровое изображение составляется из мельчайших точек (пикселов) –

цветных квадратиков одинакового размера. Растровое изображение подобно 

мозаике - когда приближаете (увеличиваете) его, то видите отдельные пиксели, 

а если удаляете (уменьшаете), пиксели сливаются. 

Компьютер хранит параметры каждой точки  изображения (её цвет, 

координаты). Причём  каждая точка представляется определенным количеством 

бит (в зависимости от глубины цвета). При открытии файла программа 

прорисовывает такую картину как мозаику – как последовательность точек 

массива. Глубина цвета - сколько битов отведено на хранение цвета  каждой 

точки:- в черно-белом - 1 бит - в полутоновом - 8 бит - в цветном - 24 (32) бита 

на каждую точку. 

Растровые файлы имеют сравнительно большой размер, т.к. компьютер 

хранит параметры всех точек изображения.  

Поэтому размер файла зависит от параметров точек и их количества: 

– от глубины цвета точек,

– от размера изображения (в большем размере вмещается больше точек),

– от разрешения изображения (при большем разрешении на единицу площади

изображения приходится больше точек). 

Чтобы увеличить изображение, приходится увеличивать размер пикселей-

квадратиков. В итоге изображение получается ступенчатым, зернистым. 

Для уменьшения изображения приходится несколько соседних точек 

преобразовывать в одну или выбрасывать лишние точки. В результате 

изображение искажается: его мелкие детали становятся неразборчивыми (или 

могут вообще исчезнуть), картинка теряет четкость. 

Исходное изображение Фрагмент увеличенного 
изображения 



 

Растровое изображение нельзя расчленить. Оно «литое», состоит из 

массива точек. Поэтому в программах для обработки растровой графики 

предусмотрен  ряд инструментов для выделения элементов «вручную». 

Панель свойств (параметров) — панель, на которой отображаются 

свойства выбранного инструмента. 

Панели - вспомогательные окна служат для выполнения различных 

операций над изображениями. 

Разрешение изображения — количество пикселей в единице длины 

изображения. Разрешение изображения измеряется в пикселях на дюйм. 

Назначение пунктов меню главного окна: 

Меню File (Файл) содержит команды ввода/вывода изображений; 

Меню Edit (Правка) содержит команды редактирования (вырезание, 

копирование и др.), а также команды преобразований всей иллюстрации и ее 

фрагментов (вращение, искажение, масштабирование, зеркальное отражение и 

др.); 

Меню Image (Изображение) содержит команды тоновой и цветовой 

коррекции, изменения цветовой модели изображения и некоторые другие;  

Меню Layer (Слои) содержит команды управления слоями изображения; 

Меню Select (Выделить) содержит команды для работы с выделенными 

областями; 

Меню Filter (Фильтры) содержит команды, реализующие специальные 

графические эффекты (фильтры); 

Меню View (Вид) содержит команды настройки экрана (изменение 

масштаба изображения, включение/выключение измерительных линеек, сетки и 

др.); 

Меню Window (Окно) содержит команды для отображения и удаления с 

экрана панелей (вспомогательных окон), а также команды размещения окон 

документов; 

Меню Help (Помощь) содержит команды для получения справочной 

информации. 

Этапы выполнения задания: Запустить программу Adobe Photoshop. 

Озаглавить документ «Задание 1». Установить размеры изображения (А4). 

Разрешение 300 ppt, фон прозрачный. Открыть новое изображение, загрузить в 

«Задание1», трансформировать, поменять размер, палитру. Сохранить 

полученный результат (см. Приложение 1, задания 1-15.1). 



 

Практическая работа 1.2 

 Выделение и трансформация 

Норма времени: 2 часа 

Цель работы: познакомиться с основными особенностями инструментов. 

Познакомиться с особенностями выделения объектов и трансформациями. 

Кадрировать изображения.  

Студент должен знать: 

Инструменты выделения правильной и произвольной области. 

Инструменты заливки, трансформации 

Команды меню. 



 

Маски. Кадрирование изображения. 

Студент должен уметь: 

Пользоваться палитрой History, инструментами выделения правильной и 

произвольной области, заливки, трансформации. 

Использовать команды меню. Выделять области правильной и произвольной 

формы. Выполнять трансформацию выделенных областей. 

Задание: Выбор нужных инструментов, выделение области 

предложенным способом, трансформация. 

Методические рекомендации по выполнению работы: Только 

выделенную область можно переместить с одного изображения на другое. При 

ретушировании, раскрашивании, а также тоновой и цветовой коррекции все 

изменения производятся только в выделенной области и не могут повлиять на 

остальную часть изображения. В растровой графике не существует объектов. 

То, что глаз воспринимает как дерево, цветок, лицо человека — это всего 

лишь набор разноцветных пикселей. Изображение, расположенное за 

пределами выделения, называется маскированной областью. Эта область 

недоступна для редактирования и, следовательно, защищена от случайных 

изменений. Если на изображении существует выделенная область, то все 

инструменты редактирования действуют только в пределах этой области, а 

остальная часть изображения остается неприкосновенной — маскированной 

Чтобы создать выделение, т. е. точно выбрать нужный набор пикселей, часто 

требуется немало сил и времени.  

Средства выделения: группа инструментов Marquee (Область), группа 

инструментов Lasso (Лассо)» Magic Wand (Волшебная палочка) и др. Для 

выделения фрагментов изображений в виде прямоугольников и овалов 

используются инструменты Rectangular Marquee (Прямоугольная область) 1 и 

Elliptical Marquee (Эллиптическая область) Инструмент Lasso (Лассо) позволяет 

выделять области произвольной формы, рисуя контур выделения курсором 

мыши. Однако трудно создать точную линию, используя мышь для рисования 

на экране. Не всегда удается выделить с помощью Lasso (Лассо) область со 

сложной границей изображения (изображение зверька, человека, цветка и т. д.). 

Инструмент Polygonal Lasso (Многоугольное Лассо)' используется для 

выделения многоугольников. В этом случае пользователь задает точки на 

изображении, a Photoshop автоматически строит между ними отрезки прямых. 

Инструмент Magnetic Lasso (Магнитное Лассо) очень удобен для выделения 

областей неправильной формы с четкими контурами.  

Для рисования контура области используется мышь. При этом граница 

выделения (мерцающий пунктир) «прилипает» к линии, которая разделяет 

сильно отличающиеся по яркости и цвету участки изображения. В ряде случаев 

можно воспользоваться инструментом Magic Wand (Волшебная палочка), 

который выделяет области, состоящие из близких по цвету пикселей, Степень 

близости цветовых оттенков пользователь может задать в поле Tolerance 

(Порог) на панели свойств Волшебной палочки. Важно помнить, что Photoshop 

выбирает близкие цвета, исходя из цвета пикселя в точке щелчка мышью. 

Поэтому форма выделения может различаться в зависимости от того, в какой 



 

точке был сделан щелчок. При необходимости границу выделения можно 

уменьшить, увеличить или повернуть.  

После того, как выделение создано и, возможно, уточнено, над 

выделенной областью выполняют различные преобразования: перемещение, 

копирование, масштабирование, вращение, закрашивание, осветление, 

затемнение, зеркальное отражение и др.  

Этапы выполнения задания:  Прежде, чем переместить фрагмент 

изображения или изменить его яркость, необходимо сообщить растровой про 

грамме, какая группа пикселей составляет этот фрагмент» т. е. выделить его.    

Вокруг выделенной области появится мерцающая пунктирная линия,  которую 

часто называют «муравьиной дорожкой»  или  «бегущими муравьями».  

Провести выполнение заданий, согласно подробным описаниям, на 

страницах Приложения 1 (см. Приложение 1, задания 16-30). 



 

Практическая работа 1.3  

Заливка и обводка. Свойства кистей 

Норма времени: 2 часа 

Цель работы: познакомиться с основными законами линейной 

перспективы. Научиться убедительно изображать предметы в соответствии с 

нашими зрительным восприятием видимых форм в пространстве, используя 

знания основных приемов линейной перспективы. 

Студент должен знать: 

Режимы наложения. Варианты заливки. 

Способы заливки. 

Понятие градиент. 

Студент должен уметь:  

Пользоваться линейками, направляющими и координатной сеткой. 

Использовать инструменты рисования и палитру кистей. 

Задание: Рисование фигур различной сложности и выполнение заливки, 

использование режимов наложения. 

Методические рекомендации по выполнению работы. Инструменты 

рисования в Photoshop — «кисти различного вида, «карандаш», «ластик», 

заливки. Хотя программа поддерживает возможность создания иллюстраций, 

все-таки компьютерные художника предпочитают использовать 

специализированные программы рисования, Объясняется это тем, что 

Photoshop имеет сравнительно ограниченный набор средств для создания 

рисунков. В Photoshop к инструментам рисования относятся Pencil (Карандаш)» 

Brush (Кисть) и Eraser (Ластик), В ряде случаев считают, что инструменты Paint 

Bucket (Заливка), Gradient (Градиент) и Smudge (Палец) также являются 

инструментами рисования. Инструмент Brush (Кисть) используется для рисова-

ния линий с плавным расплывчатым контуром.  



 

Принцип действия Кисти напоминает рисование на бумаге. При работе с 

этими инструментами нужно просто перемещать курсор мыши по экрану. Для 

создания рисунка большое значение имеет правильный выбор параметров 

инструмента. Эти параметры отображаются на панели свойств.  

У кисти панель свойств отличается лишь незначительными деталями. 

Главную роль в ней играет раскрывающийся список Brush (Форма кисти), 

который позволяет устанавливать размер и форму кончика инструмента. После 

того, как создан эскиз рисунка, его можно закрасить инструментами Paint 

Bucket (Заливка), Gradient (Градиент) и Smudge (Палец). Инструмент Paint 

Bucket (Заливка) выполняет закраску однородным цветом или узором. 

Инструмент Gradient (Градиент) предназначен для создания заливки с 

плавными переходами между различными цветами. Инструмент Smudge 

(Палец) используется для смещения и смешивания цветов соседних пикселей. 

 Этапы выполнения задания:  Установить курсор на пиктограмму инст-

румента Brush (Форма кисти). Рядом с пиктограммой появится название 

инструмента. Буква в скобках — «закрепленная» за инструментом клавиша.  

Щелкнуть на пиктограмме инструмента или нажать «закрепленную» 

клавишу. Выбранный инструмент будет изображен на светлом фоне. 

Установить курсор на пиктограмму инструмента, где есть треугольник. Нажать 

кнопку мыши и дождаться появления дополнительных инструментов.  

Отпустить кнопку мыши. Провести выполнение заданий, согласно 

подробным описаниям, на страницах Приложения 1(см. Приложение 1, задания 

31-51). 



 

Практическая работа 1.4  

Просмотр изображения. Многослойные изображения 

Норма времени: 2 часа 

Цель работы: познакомиться с многослойными изображениями. 

Научиться работать со слоями. 

Студент должен знать: 

Основы работы со слоями. 

Текстовые слои. Стили слоя. 

Студент должен уметь: 

Создавать эффекты слоев. 

Создавать изображения на прозрачном слое. Использовать слой-маску. 

Задание: Увеличение масштаба просмотра изображения. Создание 

многослойных изображений. 

Методические рекомендации по выполнению работы Панель Navigator 

(Навигатор) состоит из окна просмотра и строки управления масштабом (в 

нижней части). Ввести новое значение масштаба в поле ввода в левом нижнем 
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углу палитры или переместить регулятор (в форме треугольника) по шкале 

вправо или щелкнуть на кнопке увеличения масштаба (с большими 

треугольниками). Каждый следующий щелчок на этой кнопке увеличивает 

масштаб изображения на фиксированное значение. 

Этапы выполнения задания:  Вариант 1- Выполнить команду View|Zoom 

In (Просмотр|Увеличить). В строке заголовка окна документа, а также в строке 

состояния главного окна (слева) будет выведен масштаб изображения в 

процентах.   Вариант 2-  Выбрать инструмент Zoom (Масштаб). Щелкнуть на 

пиктограмме на панели свойств. Переместить курсор мыши на изображение. На 

изображении появится лупа со знаком «+». Щелкнуть кнопкой мыши. 

1. Откройте фотографию

2. Создайте новый слой - нажмите Ctrl+Shift+N . Можете дать название

новому слою "Тень" 

3. Выделите глаза с помощью инструмента, когда первый будет готов,

зажмите Shift и выделите второй. Теперь возьмите мягкую черную кисть 

подходящего вам размера и прокрасьте ею вдоль выделения, как показано на 

рисунке. Убедитесь, что вы стоите на слое "тень". Черный цвет будет 

рисоваться только внутри выделения.  

4. Поменяйте режим смешивания слою "тень" на Multiply (Умножение) и

уменьшите прозрачность до 40%. Нажмите Ctrl+D чтобы снять выделение 

6. Растушуйте выделение на 5 px

Select - Feather - 5 px - OK (Выделение - 

Растушевка - 5 px) 

7. Скопируйте выделение на новый

слой, для его нажмите Ctrl+Alt+J. 

Убедитесь, что вы стоите на оригинальном слое, когда производите 

копирование. Назовите слой с радужной оболочкой "осветлитель" Вот как 

должна выглядеть ваша панель слоев. 

8. К слою "осветлитель"

примените фильтр. Filter - 

Sharpen - Unsharp Mask (Фильтр - 

Резкость - Контурная резкость). 

Примените настройки. 

9. Уменьшите прозрачность

этого слоя до 50% 



 

10. Теперь добавим блики в правом нижнем углу глаза с помощью

инструмента (осветлитель). Установите такие же настройки (кисть: маленькая, 

мягкая; диапазон: света) 

Начните осветлять - проведите несколько 

штришков в правом нижнем углу. С каждым 

новым штришком то место будет становиться 

все светлее. Не перестарайтесь! 

11. Создайте новый слой над слоем "осветлитель".Назовите его "левый

блик". Установите белый цвет как основной. Возьмите мягкую маленькую 

кисть. Нарисуйте белые линии по левому краю глаза. Установите этому слою 

режим Overlay (Перекрытие) Теперь от этих глазок взгляд оторвать 

невозможно. Увеличить масштаб просмотра изображения. 

Практическая работа 1.5  

Цвет в растровой графике 

Норма времени: 2 часа 

Цель работы: познакомиться с основами цветовой и тоновой коррекции. 

Корректирующими слоями. Изучить образцы цвета. 

Студент должен знать: 

Основы цветовой и тоновой коррекции. 

Корректирующие слои.  

Образцы цвета. 

Студент должен уметь: 

Использовать знания и умения по корректировке цвета любого 

изображения различной сложности. 

Задание: Создание «маски» используя знания по цветовой коррекции 

изображения. 

Методические рекомендации по выполнению работы. Цвет может 

получиться в процессе излучения и в процессе отражения, поэтому существуют 

два противоположных метода его описания: аддитивная и субтрактивная 

цветовые модели. Аддитивная цветовая модель (RGB), используемая в 

компьютерных мониторах, базируется на трех основных цветах — красном, 

зеленом и синем. Графические редакторы, как правило, позволяют ком-

бинировать требуемый цвет из 256 оттенков красного, 256 оттенков зеленого и 

256 оттенков синего. Таким образом, на экране компьютера можно получить 



 

более 16 миллионов цветовых оттенков. Субтрактивная цветовая модель 

(CMYK),  используемая для печати изображений, базируется на четырех основ-

ных цветах — голубом, пурпурном, желтом и черном. Для преобразования 

данных модели RGB в модель CMYK применяется программа цветоделения. В 

моделях RGB и CMYK различна природа получения цвета. Поэтому цвет, 

который мы видим на мониторе, не всегда можно воспроизвести при печати. 

Обычно на экране цвета выглядят ярче, чем на бумаге. Цветовой охват — 

множество цветов, которые могут быть созданы в цветовой модели. Самый 

широкий цветовой охват — натуральный — включает все различимые глазом 

цвета. По сравнению с ним цветовой охват RGB несколько меньше, а охват 

CMYK — еще меньше, чем RGB. Ряд графических редакторов (Adobe 

Photoshop) предоставляют информацию о тех цветах, которые не могут быть 

точно воспроизведены при печати. Существуют графические редакторы, 

которые позволяют создавать на экране рисунки в цветах CMYK. Модели 

цветов RGB и CMYK базируются на ограничениях, накладываемых 

аппаратурой. Интуитивным способом описания цвета является его 

представление в виде цветового оттенка (Hue), насыщенности (Saturation) и 

яркости (Brightness). Для такой системы цветов используется аббревиатура 

HSB. 

Этапы выполнения задания: Шаг 1 – Подготовка фона 

Создайте документ размером 900х600 px. Откройте обои Dark Wood (Темное 

дерево)и подгоните их размер под наш документ. 

Шаг 2 – Вырезание лица. В этом шаге мы будем добавлять цвета. Для 

начала нужно настроить цветность для всей сцены. Создайте новый 

корректирующий слой (new adjustment layer) Color Balance (Баланс цветов). 

Установите значения средних тонов (midtones) на -59; -20; +2. Изображение 

будет синеватым. Теперь нажмите Ctrl и кликните по слою Откройте 

изображение с Анжелиной Джоли и поместите его в наш документ, как 

показано на рисунке. Используя инструмент Eraser (Ластик), сотрите задний 

фон и глаза в изображении. 

Шаг 3,4 – Удаление волос с лица. Выделив слой с лицом зайдите в меню 

Filter > Blur > Surface Blur (Фильтр > Размытие > Размытие по поверхности). 

Введите значение 5 px для Radius (Радиуса) и значение 8 для Threshold 

Создайте новый слой и назовите его Cover (Покрытие). Используя инструмент 

Eye Dropper (Пипетка), выберите цвет кожи около волос. 



 

Затем, возьмите инструмент Brush (Кисть) и установите ее opacity 

(прозрачность) на 30%, а size (размер) на 25, закрашивайте на слое Cover 

(Покрытие), чтобы спрятать нежелательные волосы. Удаление половины лица 

Снова используя инструмент  Eraser (Ластик), удалите нижнюю половину 

лица, как показано на изображении. Также сотрите ухо. 

Шаг 5а – Добавление подтеков краски. Создав новый слой, назовите его 

Drips (Подтеки краски). Используя инструмент Eye Dropper (Пипетка), 

выберите цвет рядом с нижним краем. Затем используйте инструмент Brush 

(Кисть), чтобы рисовать подтеки внизу. Повторите этот шаг несколько раз с 

различными размерами кисти. Прием: Удерживайте клавишу shift во время 

рисования, чтобы добиться идеально ровных линий. Слейте слои Drips 

(Подтеки краски), Cover (Покрытие) и лицо в один слой. 

Шаг 6 – Добавление эффекта тиснения. Нажмите по слою правой кнопкой 

мыши и выберите Blending Options (Параметры наложения). Активируйте 

параметр Bevel and Emboss (Тиснение). Установите Style (стиль) на Inner Bevel 

(Внутренний скос), Depth (Глубину) на 165, Size (размер) на 50, Angle (Угол) 

55, Altitude (Высоту) на 40, Screen Opacity (глобальное освещение) 0%, Shadow 

Color (цвет тени) #DCA288, Shadow Opacity (Прозрачность тени) 100%.  

Шаг 7 – Создание блеска 

Создайте новый слой и назовите его Glow 

(Блеск). Установите цвет кисти на белый и 

размер 4. Создайте контур с помощью 

инструмента Pen tool (Перо). 

Используя Pen tool (Перо), кликните правой кнопкой мыши по 

нарисованному контуру и выберите Stroke Path (Выполнить обводку контура). 

Выберите Brush (Кисть) и активируйте Simulate Pressure (Стимулировать 

нажатие).  

Выделите верхний дубликат и зайдите в меню Filter > Blur > Gaussian Blur 

(Фильтр > Размытие > Размытие по Гауссу).  



 

Установите значение 3. Создание блеска. Фокусируйте блеск на правой 

стороне только так, будто источник света находится на той стороне. 

Шаг 8 – Добавление сверкания. Создайте новый слой поверх остальных и 

назовите его Glitter (Сверкание).  

Используя инструмент Brush (Кисть) белого цвета размером 2, нарисуйте 

крестик.  

Затем, используйте Airbrush Eraser tool (Ластик с распылителем) размером 65, 

сотрите четыре края крестика. Дублируйте несколько раз слой Glitter 

(Сверкание) и разместите их поверх лица. 

Практическая работа 1.6  

Реставрация изображений 

Норма времени: 4 часа 

Цель работы: познакомиться с основными командами фильтров 

резкости, фильтров размытия. Устранять дефекты изображения. Удалять 

ненужные детали. Заменять цвет и использовать эффект перспективы. 

Студент должен знать: 

Команды фильтра резкости. 

Команды фильтра размытия. 

Студент должен уметь: 

Устранять дефекты изображения. 

Удалять ненужные детали. 

Заменять цвет и использовать эффект перспективы. 

Задание: Редактирование изображений, эффект «гламур». 

Методические рекомендации по выполнению работы. Кроме тоновой и 

цветовой коррекции многие фотографии нуждаются в ретушировании. 

Ретуширование, как правило, включает в себя повышение резкости и 

устранение .мелких дефектов. После усиления резкости элементы изображения 

становятся более отчетливыми. Устранить мелкие дефекты — это значит 

удалить с фотографии загрязнения и царапины, убрать морщинки с лица, 

отбелить зубы, подправить прическу и т, д. Ретуширование позволяет сделать 

любого человека красивее и моложе. Вот почему после обработки в Photoshop 

персонажи и окружающая их обстановка могут выглядеть лучше, чем в 

реальной жизни. 

Устранение дефектов фильтром Dust & Scratches (Пыль и царапины). При 

ретушировании прежде всего необходимо избавиться от мелких погрешностей, 

к которым относятся различные загрязнения (пыль, пятна) и царапины. Для 
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этого удобно воспользоваться фильтром Dust & Scratches (Пыль и царапины).   

Этот  фильтр  усредняет  цвета  соседних  пикселей. Следует иметь ввиду, что 

при устранении более крупных дефектов фильтром Dust & Scratches (Пыль и 

царапины) изображение может потерять резкость.  

Использование инструмента Clone Stamp (Штамп). Одной из самых 

замечательных и интересных особенностей ретуширования в Photoshop 

является возможность устранения с фотографии ненужных объектов — мусора 

на улицах, телефонных будок  электрических проводов, незнакомых людей и т. 

д. Инструмент Clone Stamp (Штамп) удаляет нежелательные элементы путем 

клонирования. Клонирование — затирание некоторой области изображения 

путем копирования на ее место другой части того же изображения. 

Часто встречаются фотографии перегруженные лишними деталями, от 

которых необходимо избавиться. Здесь снова поможет инструмент Clone Stamp 

(Штамп). Еще один пример ретуширования — реставрация старых фотографий, 

т. е. восстановление их первоначального облика. 

Обычно в подобных ситуациях сначала следует выполнить тоновую и 

цветовую коррекцию, а затем устранить дефекты фильтром Dust & Scratches 

(Пыль и царапины) и инструментом Clone Stamp (Штамп). При использовании 

штампа подходить к дефектам нужно с разных сторон, постоянно изменяя 

образец, а также размер и форму кончика штампа. Кроме того, фотографии 

можно придать теплый оттенок сепии, оформить ее с помощью виньетки или из 

черно-белой превратить в цветную. Таким образом, ретуширование позволяет 

не только реставрировать фотографию, но и сделать ее лучше, чем она была на 

самом деле. Однако следует помнить, что компьютерная ретушь во многом 

является «ручной» работой, которая требует навыка, терпения и 

художественного вкуса. 

Этапы выполнения задания:  

Шаг 1. Откройте изображение в Фотошопе, дублируйте его. Удалите все 

неровности на коже с помощью Лечащей/Восстанавливающей кисти .  

                                                        
Шаг 2. Как только вы закончите работу с инструментом , дублируйте 

слой еще раз и примените к нему Фильтр - Шум - Пыль и царапины (Filter > 

Noise > Dust & Scratches). Для своего примера я использовала настройки такие: 

радиус 5 px и порог 0. Настройки зависят от качества фотографии. В результате 

мы должны получить мягкое размытие изображения, примерно так: 
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Шаг 3. Следующий фильтр, который мы будем 

использовать, Размытие по Гауссу (Filter > Blur > 

Gaussion Blur)  

И снова настройки на ваше усмотрение, радиус 

= 2.  

Шаг 4. И финальный шаг в создании новой матовой кожи - это 

добавление еще одного фильтра Шум - Добавить шум (Filter > Noise > Add 

Noise). Мы все прекрасно знаем, что человеческая кожа не может быть 

идеально гладкой. Благодаря этому фильтру кожа примет нужную текстуру и 

будет смотреться более реалистично. Монохромный шум в количестве 0.7%. 

                                          
Шаг 5. Внизу палитры слоев нажмите на кнопку Добавить маску слоя 

(Add a layer mask). Рядом со слоем появится белый квадратик. Возьмите , 

установите черный цвет и кликните по документу.  

Если не получается, то убедитесь что в качестве основного цвета стоит черный, 

затем нажмите Alt+Backspaceю. "Мутный" слой спрячется, а нижний "четкий" 

появится. 

Шаг 6. Возьмите инструмент Кисть, убедитесь, что выбран именно белый 

цвет. Установите жесткость кисти на 0. Вы можете также уменьшить ей 

прозрачность. Ваша задача - красить белой кистью в тех местах, где кожу 

нужно обновить, но не затрагивать глаза, брови, губы, волосы, чтобы они не 

потеряли свою резкость. Если вы случайно закрасили лишнего, то 

переключитесь на черную кисть и все исправьте. Вот что у вас должно 

получиться по окончанию пластических работ: 

                                                        
Шаг 7.  Кожа у девушки приятного цвета, поэтому никаких цветовых 

настроек применять не будем.   

Шаг 8. А теперь мы добавим немного резкости нашему изображению. 

Дублируйте средний слой, у меня называется "лечь кисть". Измените ему 

режим смешивания на Перекрытие (Overlay). Примените Фильтр - Другие - 

Цветовой Контраст (Filter > Other > High Pass). Установите значение радиуса. 
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Шаг 9. Слейте все слои, кроме последнего (чтобы самим было интересно 

посмотреть, как было и как стало). Дублируем верхний слой, режим наложения 

меняем на Перекрытие (Overlay). Добавляем фильтр Размытие по Гауссу: 

                                                              
Добавим маску слоя и уберем черной кистью размытость с волос, чтобы 

оставить их блеск. Немножко добавим резкости. Применяем Фильтр - Резкость 

- Контурная резкость (Sharp - Unsharp mask) 2 раза. В результате получается 

восточная красавица. 

                                                      
 

Раздел 2.  КОНТУРЫ. ФИЛЬТРЫ. ОПЕРАЦИИ 

Практическая работа 2.1  

Контурные слои 

Норма времени: 2 часа 

Цель работы: познакомиться с основными инструментами для создания 

контуров. Изучить обычные контуры и способы их применения, основные 

приемы работы с контурами, создать контурное изображение объекта. 

Студент должен знать: 

Инструменты для создания контуров. 

Обычные контуры и способы их применения. 

Основные приемы работы с контурами. 

Студент должен уметь: 
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Применять знания и умения по использованию инструментов создания 

контуров. 

Задание: Создание контура предложенного объекта. 

Методические рекомендации по выполнению работы. Несмотря на то, что 

работа с контуром ведется в растровой программе, информация о нем хранится 

в памяти компьютера в виде математических описаний {в векторной форме). 

Контуры — основное средство создания иллюстраций в векторных 

программах. Именно из контуров (кривых) создаются разнообразные рисунки 

сложной формы. В растровых программах это не так. В Photoshop контуры 

имеют вспомогательное значение и не являются частью изображения. Чтобы 

контур появился в результирующем изображении, его необходимо обвести 

каким-нибудь рисующим инструментом. Область внутри контура можно 

закрасить разнообразными цветами. Контур легко преобразовать в границу 

выделения. Кроме того, с помощью контура можно выделить любой фрагмент 

фотографии для экспорта в другие программы. 

Контуры бывают открытыми и замкнутыми. У замкнутого контура 

невозможно различить начальную и конечную точки. Примером замкнутого 

контура может служить окружность. Важнейшими элементами контуров 

являются опорные точки и сегменты. Сегмент — участок контура, расположен-

ный между двумя опорными точками. При создании криволинейного контура 

важно помнить, что каждая опорная точка имеет две направляющие линии 

(рычаги). Если в процессе создания контур получился не очень точным, его 

можно отредактировать, перемещая опорные точки и направляющие.  

Контуры очень полезны в тех случаях, когда необходимо выделить 

сложную по форме область изображения, например, для создания коллажа. 

Paintbrush (Кисть), Pencil (Карандаш), Eraser (Ластик) -— инструменты 

растровой графики. Реп (Перо) — инструмент векторной графики. Перо 

предназначено для вычерчивания контуров — прямых и кривых линий. В 

Adobe Photoshop контуры имеют вспомогательное значение и не являются 

частью изображения. Важнейшими элементами контуров являются опорные 

точки и сегменты. Контуры можно редактировать, перемещая опорные точки и 

их направляющие.  

Чтобы контур появился в результирующем изображении, его необходимо 

обвести каким-нибудь рисующим инструментом.  

Область внутри контура можно закрасить разнообразными цветами.  

Контур легко преобразовать в границу выделения, а границу выделения 

— в контур.  

Контур обрезки используется для выделения фрагмента фотографии для 

экспорта в другие программы. 

Этапы выполнения задания: Первым шагом будет создания нового 

документа, 500х500 пикселей, 72dpi. Залейте его линейным градиентом с 

цветами #112b05 и #23590a. Применим Filter > Sketch > Water Paper 

(Фильтр>Эскиз>Мокрая бумага) с настройками показанными ниже: 
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Теперь находим подходящую картинку. Для этого можете 

воспользоваться своими ресурсами или воспользоваться этой. Перетащим её на 

центр холста, как на картинке ниже. Ставим непрозрачность 7% для этого слоя. 

Перед тем как делать силуэт девушки нужно выставить следующие настройки 

для кисти: 

                                              
Ставим основной цвет #c0ff00. После берём инструмент Pen Tool (Перо). 

Рисуем линию, используя инструмент Перо . Клик правой клавишей мыши и 

выбираем Stroke Path (Обводка). 

                   
Выскочит маленькое диалоговое окно, как на скриншоте ниже. 

Убедитесь, что там выбрана Кисть и галочка возле Имитировать нажим. 

                  
Далее щелкнем правой клавишей мыши и выберем Delete Path (Удалить 

обводку). Проделаем такие действия несколько раз. 

http://www.photoshopstar.com/wp-content/uploads/2008/09/glowing_woman_silhouette_woman.jpg
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После переходим на слой с картинкой и удаляем его. Нам он больше не 

понадобится. Потом применим Drop Shadow (Тень) и Outer Glow (Внешнее 

свечение) для каждого из слоев силуэта. Оцените окончательный вариант. 

 

 

 

 

 

Практическая работа 2.2  

Группы фильтров 

Норма времени: 4 часа 

Цель работы: Научиться самостоятельно использовать группы фильтров, 

свободно владеть приемами обработки и коррекции изображения. 

Студент должен знать: 

Кисти, различные режимы смешивания 

Группу фильтра Artistic (Художественный). 

Группу фильтра Render (Освещение и визуализация). 

Группу фильтров искажения. 

Группу фильтра Noise (Шум). 

Группу фильтра Pixelate (Пикселизация). 

Группу фильтров создания текстуры. 

Группу фильтра Stylize (Стилизация) 

Студент должен уметь: Грамотно использовать фильтры. 

Задание: Создание «волшебного эффекта» представленного изображения 

используя группы фильтров, кисти. 

Этапы выполнения задания: 

Шаг 1 и 2. создайте новый документ Файл-Новый (File-New), с размерами 

 1920×1200px /72ppi. Затем возьмите Инструмент Заливка (Paint Bucket 

Tool)(G) и залейте новый фоновый слой цветом, номер которого вы видите на 

картинке ниже. Возьмите  Инструмент Кисть (BrushTool) (B), установите 

прозрачность 20% .Другие настройки кисти смотрите на картинке ниже. 

                                                                
Шаг 3. Теперь на новом слое при помощи кисти делаем несколько мазков 

(номер цвета смотрите на картинке). И еще несколько другим цветом на еще 
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одном новом слое. Измените его Режим Смешивания (Blend Mode) на 

Осветление Основы (ColorDodge). 

        
Шаг 4. Теперь возьмите фото девушки-модели и поместите его на ваш 

документ. Вы же можете использовать любое. 

Шаг 5 и 6. Отделите фигуру девушки от фона, на котором она находится. 

Сделать это вы можете любым удобным для вас способом. Инструмент Перо 

(PenTool (P)), Инструмент Волшебная Палочка (MagicWandTool (W)), 

Инструмент Магнитное Лассо (MagneticLasso (L)), либо же самый простой 

Фильтр-Извлечь (Filter-Extract (Alt+Ctrl+X)). Создайте новый слой. На нем при 

помощи Инструмента Кисть(Brush Tool) с цветом #BA93B3 сделайте 

небольшую россыпь точек разного размера, а потом еще немного чисто-белых. 

                                
Шаг 7. Теперь при помощи Инструмента Эллипс (Ellipse Tool (U)) 

сделайте вот такой кружок. Добавьте прозрачности. И в итоге у нас получился 

полупрозрачный круг: 

                                                         
Шаг 8. Теперь скопируйте этот слой (Ctrl+J) несколько раз и, используя 

инструмент Перемещение (MoveTool (V) и клавишу Alt  разместите кружки 

в произвольном порядке вокруг девушки, трансформируя их. 

                         
Шаг 9. Снова создайте новый слой. Нам нужно создать на слое подобие 

свечения вокруг девушки. Настройки кисти для этого действия приведены 

ниже. (Можно добавить параметры смешения «Перекрытие», «Мягкий свет») 
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Шаг 10. Теперь добавляем Новый корректирующий слой – Кривые 

(Createnewfilloradjustmentlayer-Curves). Настройки - на картинке ниже. Теперь 

ваша работа выглядит  контрастнее и насыщеннее. 

                              
Шаг 11. При помощи Инструмента Эллипс (EllipseTool (U) на новом 

слое сделайте еще один кружок. Заливка (Fill) этого слоя 0%, а Прозрачность 

(Opacity) - 70%. Зальем градиентом по вашему вкусу))) Также мы добавим 

этому слою несколько стилей. Для начала Внутренняя Тень (Inner Shadow) с 

настройками, которые приведены ниже. Далее Внутреннее Свечение (Inner 

Glow), как показано на рисунке. Затем Тиснение (BevelandEmboss). 

          
Шаг 12. Копируйте слой с пузырем и, при помощи Свободной 

Трансформации (Ctrl+T) постарайтесь его деформировать. Используйте 

следующие параметры Искривления (Warp). Проделайте это действие 

несколько раз. Вот, что у вас должно получиться 

                                              
Шаг 13. На новом слое нам нужно сделать несколько линий при помощи 

Инструмента Кисть (Brush Tool) c настройками, представленными на 

рисунке. Теперь немного размажьте их при помощи Инструмента Палец 

(SmudgeTool (R) с Нажимом (Strength) около 50%. 
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Шаг 14. Режим смешивания этому слою измените на Перекрытие 

(Overlay). Затем создайте дубликат этого слоя. 

                                                  
Шаг 15. На новом слое нам нужно применить Инструмент Кисть (Brush 

Tool) белого цвета, с уровнем прозрачности 10%. Другие настройки ниже. У вас 

должно получиться что-то вроде тумана. Изменим режим смешивания слоя на 

Перекрытие (Overlay). 

              
Шаг 16. На новом слое кистью добавьте еще немного точек (цвет #EC008C) 

приблизительно так, как показано на рисунке. А после на новом слое еще 

немного белых. 

                              
Шаг 17. Создайте копию слоя с белыми точками, и примените к нему 

Фильтр-Размытие-Размытие в движении (Filter>Blur>MotionBlur). Теперь наши 

точки приобрели более динамичный вид. Получите окончательный результат. 
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Практическая работа 2.3 

Операции по монтажу изображений (коллаж) 

Норма времени: 4 часа 

Цель работы: познакомиться с основными монтажа изображений. 

Студент должен знать: 

Понятие монтажа, виды 

Операции с инструментами выделения объектов. 

Способы модификации изображения, трансформациями 

Параметры наложения 

Свойства изображений, цветовые режимы 

Работу со слоями, параметры и свойства слоя 

Студент должен уметь: 

Монтировать изображения, создавать единую композицию (коллаж) 

Задание: Из предложенных самостоятельных изображений создание 

единой композиции. 

Методические рекомендации по выполнению работы. Термин   «коллаж»   

произошел от французского слова «collage» — «наклеивание». В 

компьютерном коллаже операции вырезания и наклеивания заменяются 

операциями выделения и перемещения. Кроме того, можно увеличить, 

уменьшить, скопировать, повернуть или зеркально отразить отдельные 

фрагменты для создания законченной композиции. Для создания коллажей в 

Photoshop используются слои. Слой можно сравнить с листом прозрачной 

пленки, на которую нанесен рисунок. Изображение может содержать один или 

много слоев. Если сложить такие слои стопкой, то получится изображение из 

нескольких рисунков. Даже десяток слоев не исказит самый нижний из них, так 

как пленка каждого слоя абсолютно прозрачна. Работа со слоями выполняется 

под управлением панели Layers (Слои). На ней отображается информация о 

слоях активного документа. Новый файл создается на слое заднего плана (Back-

ground). Название этого слоя на панели Layers (Слои) пишется курсивом. В 

процессе создания коллажа одна фотография выбирается в качестве фона, а 

выделенные фрагменты других изображений перемещаются на этот фон. Таким 

образом, в документе с изображением фона появляется новый слой. 

Информация о нем фиксируется на панели Layers (Слои). Пиктограмма «глаз» в 

левом вертикальном ряду панели Layers (Слои) означает, что данный слой — 

видимый. Щелкая на этих пиктограммах, можно прятать или показывать 

связанные с ними слои. Прозрачные области слоя отображаются на экране в 

виде клетчатого узора. Перед выполнением любого преобразования слой 

необходимо выделить. Для этого нужно щелкнуть на его пиктограмме на 

панели Layers (Слои). Выделенный слой называется активным. Когда слой 

становится активным, рядом с его именем в вертикальном ряду справа от 

«глаза» I появляется пиктограмма о кисть». Photoshop позволяет удалять, 

перемещать, вращать, масштабировать отдельные слои, изменять порядок 

слоев, переносить фрагменты изображений с одного слоя на другой. Слой 

Background является особым слоем, так как он всегда самый дальний. Его 

нельзя вращать и масштабировать. Чтобы к слою заднего плана можно было 
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применить какое-либо преобразование, его сначала нужно превратить в 

обычный слой путем простого переименования. Слои выделяются и 

редактируются по одному. Однако может возникнуть ситуация, когда 

некоторую операцию нужно выполнить сразу над несколькими слоями. В этом 

случае несколько слоев документа можно связать и затем воздействовать на 

них как на группу. Легкость выделения, копирования, перемещения слоев, их 

масштабирования и ориентации позволяет создавать самые разнообразные 

коллажи. Каждый новый слой, добавляемый к документу, увеличивает размер 

файла. Чтобы не допустить чрезмерного увеличения размера файла, 

рекомендуется объединять слои, работа с которыми закончена.  

Коллаж — сочетание нескольких фрагментов различных изображений в 

одном. Компьютерный коллаж создается с помощью следующих операций над 

отдельными фрагментами изображений: выделение, перемещение» 

копирование, зеркальное отражение, увеличение, уменьшение. Для создания 

коллажей в Photoshop используются слои.  

Слой можно сравнить с листом прозрачной пленки, на которую нанесен 

рисунок. Работа со слоями осуществляется с помощью панели Layers (Слои). 

Новый файл создается на слое заднего плана. В процессе создания коллажа 

одно изображение выбирается в качестве фонового, а выделенные фрагменты 

других перемещаются на этот фон» В результате этого в документе с фоном 

появляется новый слой. Перед выполнением преобразований слой необходимо 

выделить. Для этого нужно щелкнуть на пиктограмме слоя на панели слоев 

Photoshop позволяет удалять, перемещать, вращать слои, изменять порядок 

расположения слоев, переносить фрагменты изображений с одного слоя на 

другой. Несколько слоев документа можно связать и затем воздействовать на 

них как на группу. Чтобы не допустить чрезмерного увеличения размера файла, 

рекомендуется объединять слои, работа с которыми закончена. 

Этапы выполнения задания.  

 Шаг 1. Открыть предложенные самостоятельные изображения. 

Шаг 2.  Вырезание. Используйте инструмент Lasso (Лассо), но есть 

много способов, чтобы это сделать, поэтому используйте тот, с которым вы 

обычно работаете. 

Ваша работа никогда не будет выглядеть реалистично, если вы не будете 

вырезать объекты должным образом. Не стоит заострять внимание на траву в 

нижней части одежды мальчика. Она будет скрыта облаками. Нам понадобятся 

только шея и голова жирафа. Не нужно вырезать животное целиком 
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Шаг 3. Размещение. Теперь откройте задний фон – изображение со 

звездным пространством. Поместите на него изображения, которые вы 

вырезали. Откройте изображение с облаком и так же поместите его на звездное 

пространство. 

 
Шаг 4. Смешивание. Для начала мы создадим облако. 

Кликните по слою с облаком, затем нажмите кнопку Add vector mask 

(Добавить векторную маску). Кнопка расположена в нижней части Layers 

palette (Палитра слоев) (если вы не видите эту палитру, нажмите клавишу F7 на 

своей клавиатуре). Убедитесь, что векторная маска активна (если нет, кликните 

по ней). 

                   
Теперь нажмите клавишу G на своей клавиатуре (= Paint Bucket Tool 

(Заливка)) и заполните векторную маску черным цветом. 

После этого облака исчезнут, но не волнуйтесь, мы снова будем рисовать их.  

Нажмите B (= Brush Tool (Кисть)). Выберите белый цвет. Убедитесь, что 

векторная маска до сих пор активна и начните закрашивать на том участке, где 

вы хотите, чтобы облака стали видимыми. 

Для более реалистичного эффекта используйте мягкую круглую кисть. А 

по краям используйте кисть с меньшей прозрачностью. Еще две вещи перед 

тем, как перейти к следующему шагу: Во-первых, мы сделаем светящиеся 

звезды. Нажмите на слой со звездами, затем на кнопку Add a layer style 

(Добавить стиль слоя). 

                          
Нужно корректировать яркость и контраст. (Brightness and Contrast 

(Яркость и Контраст > Brightness (Яркость) -50, Contrast (Контраст) -30). 

Изменить уровни у звезд ((Levels (Уровни) > 0; 0,80; 255) и у жирафа (13; 0,54; 

235).  
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Шаг 5. Создание удочки. Создайте новый слой и назовите его “fishing 

rod” (удочка). Нажмите B, чтобы вызвать кисть, выберите светло коричневый 

цвет и нарисуйте веточку. После того, как вы придадите нужную форму удочке, 

кликните по иконке Add a layer style (Добавить стиль слоя) и используйте 

следующие настройки. Это придаст удочке эффект пластика, который нам 

нужен. Теперь мы нарисуем леску. Создайте еще один новый слой. 

Используйте мягкую круглую кисть белого цвета.  

                                        
Шаг 6. Освещение. Если вы посмотрите на изображение сверху, то вы 

увидите, что освещение не отлажено. Некоторые части могут быть светлее от 

сияющих звезд, а некоторые – темнее. Нажмите M (= Rectangular Marquee Tool 

(Прямоугольная область выделения)). И выделите все изображение. Затем 

зайдите в меню Edit -> Copy Merged (Редактировать > Скопировать 

совмещенные данные), затем Edit ->Paste (Редактировать > Вставить). 

Этот шаг позволит создать освещение для всей сцены. Перед тем, как мы 

сделаем это, создайте new fill (новый слой заливка) или (корректирующий 

слой), выберите Hue and saturation (Цветовой тон и Насыщенность) и 

обесцветьте изображение. Нажмите на объединенный слой и зайдите в меню 

Filter -> Render -> Lighting Effect (Фильтр > Рендеринг > Эффект освещения). В 

качестве Light type (стиль)  выберите «Omni», Intensity (Интенсивность) 35, 

Gloss (Глянец) 0; Material: 69; Exposure (Экспозиция): 0 and 

Ambience(Окружение): Источник света расположите на звезде. Теперь мы 

будем корректировать свет и тени локально. Делайте это при помощи 

инструментов Dodge Tool (Осветлитель) и  Burn Tool (Затемнитель) 

(нажмите O на своей клавиатуре). Используйте значения экспозиции около 

20%, так будет выглядеть натуральней. 
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Шаг 20. Раскрашивание. В этом шаге мы будем добавлять цвета к нашему 

коллажу. Для начала нужно настроить цветность для всей сцены. Создайте 

новый корректирующий слой (new adjustment layer) Color Balance (Баланс 

цветов). Установите значения средних тонов (midtones) на -59; -20; +2. 

Изображение будет синеватым. Теперь нажмите Ctrl и кликните по слою со 

звездами. Это активирует выделение звезд. Кликните по корректирующему 

слою (который сделал наit изображение черно-белым) и создайте новый 

корректирующий слой Color Balance (Баланс цветов), сделайте звезды 

желтыми. Повторите этот шаг и для остальных элементов изображения. Star 

(Звезда): Midtones (Средние тона): -2,-10,-52, Shadows (Тени): +3,-17,+8, 

Highlights (Свет): 0,0,-21Aura around star (Аура вокруг звезды): Midtones: 0,-5,-

49 Clothes of the boy (Одежда мальчика): Midtones: -12,+11,-19, Shadows: -

12,+39,-4 Skin (Кожа): Midtones: +53,+17,-39 Hair (Волосы): Midtones: 0,0,+46, 

Shadows: 0,-27+17 Lighting (Освещение): Midtones: +30,-40,-87 

 
Шаг 8. Особые эффекты. В этом шаге мы будем добавлять блика и 

текстуру, чтобы придать более мечтательный эффект. Для начала создадим 

блики. Создайте новый слой и залейте его полностью черным цветом. Зайдите в 

меню Filter->Render->Lens Flare (Фильтр > Рендеринг > Блики). Выберите 

вспышку, которая вам понравится и нажмите Ок. Измените blending mode 

(режим смешивания) на Lighten (Замена светлым). И прозрачность слоя 

(opacity) установите на 20%. Яркую часть вспышки поместите на звезду.  

 
Теперь откройте текстуру Боке и поместите ее в наш коллаж. Измените 

blending mode (режим смешивания) так же на Lighten (Замена светлым) и 

снизьте прозрачность до 20%. Шаг 9. Последний штрих. Этот последний шаг 

рассчитан на ваш личный вкус. “Deep blue” photo filter (фото фильтр «Глубокий 

синий»), немного уменьшив контраст (contrast) и насыщенность (saturation). 
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Раздел 3.  ПОДГОТОВКА И ПЕЧАТЬ ИЗОБРАЖЕНИЙ 

Практическая работа 3.1 

 Работа с текстом. Растрирование.  

Управление цветом 

Норма времени: 2 часа 

Цель работы: познакомиться с основными моментами работы с 

текстовыми слоями. Научиться преобразовывать  любой рисунок или фото в 

изображение, составленное из текстовых символов, чтобы сохранялись 

цветовые переходы  

Студент должен знать: 

Понятие растрирования текста, микширование каналов  

Параметры преобразования, панели инструментов  

Особенности работы с текстовыми слоями. Параметры, свойства цветового 

диапазона. Особенности текстового редактора 

Студент должен уметь: 

Преобразовывать  рисунок или фото в изображение, составленное из 

текстовых символов, чтобы сохранялись цветовые переходы  

Задание: Превращение текста в постер. 

Методические рекомендации по выполнению работы. Существуют   два   

вида   текста;   фигурный (Artistic) и простой (Paragraph). 

Фигурный текст применяется для коротких надписей и заголовков, а 

простой — для создания текстовых документов. Для простого текста 

применяют такие средства оформления, как колонки, буквицы, маркеры и др., 

которых нет при работе с фигурным текстом. Текст создается инструментом 

Text (Текст) Все шрифты можно разделить на несколько групп. Стандартные 

(наборные) шрифты служат для набора больших массивов текста. Они делятся 

еще на две группы — с засечками и без засечек (засечки — это маленькие 

черточки на краях отдельных букв). Часто используемый шрифт с засечками — 

Times, без засечек — Arial; Акцидентные шрифты используются только для 

крупных заголовков. К ним относится шрифт Algerian; Рукописные шрифты 

имитируют письмо пером или кистью, они придают особую привлекательность 

различным приглашениям. Brush Script MT — пример такого шрифта; 

Начертание шрифта может быть нормальным (Normal), полужирным (Bold), 

курсивным (Italic) и полужирным курсивным (Bold-Italic). Шрифт может быть 

подчеркнутым, а также использован для индексирования. Можно изменить цвет 

контура, а также его толщину, к тексту разрешается применять любые заливки. 

Программа позволяет размещать строку фигурного текста вдоль любой 

заданной траектории» В качестве траекторий размещения текста здесь 

использованы прямые и кривые линии. Независимо от вида текста, ему можно 

придать необходимые полиграфические параметры (шрифт, начертание, 

размер» цвет и др.). Если необходимо применить к тексту спецэффекты: ис-

пользовать эффекты объема, перетекания, создать оболочку, отредактировать 

форму отдельных символов, разместить текст вдоль траектории, преобразовать 

текст в кривые, то используют только фигурный текст. Можно размещать 



 40 

строку фигурного текста вдоль любой заданной траектории. После 

преобразования текста в кривые легко изменить форму символов, потянув за 

любой узел или траекторию точно так же, как при работе с обычными кривыми. 

Кроме того, появляется возможность масштабировать, вращать и перемещать 

отдельные символы текста. Когда применяется оболочка, объект становится 

эластичным и, таким образом» его форма подгоняется под контур оболочки. 

Этапы выполнения задания: Для работы используем широко известный 

плакат о вреде пьянства. 

Шаг 1. Конвертируем 

фотографию в черно-белый режим. 

Правильнее будет 

воспользоваться командой Image 

>Adjustments (Избражение – 

Коррекция)-Channel Mixer 

(Микширование каналов)  

Поставьте флажок Monochrome 

(Монохромный), чтобы сделать 

изображение монохромным (как можно 

догадаться из названия самого флажка). 

Нам нужно добиться плавного перехода 

оттенков, чтобы в дальнейшем, на их 

основе можно было бы наложить текст. 

Поэкспериментируйте с ползунками так, чтобы в результате подчеркнуть 

самые светлые участки на изображении и самые темные. 

Шаг 2. Текстовым редактором откройте любой текстовый файл, удалите 

символы абзаца, лишние пробелы, выделите текст и скопируйте его в буфер 

обмена CTRL+C. 

Шаг 3. Выберите из панели инструментов 

Horizontal Type Tool (Горизонтальный текст) и 

растяните область его применения на все изображение.  

Затем нажмите CTRL+V для вставки текста из 

буфера обмена.  

Цвет вставляемого текста должен быть #000000.  

Если текст не полностью закрыл окно с 

изображением (т. е. Вы выбрали небольшой текст), то 

повторите CTRL+V столько раз, пока текст не покроет 

все изображение. Шрифт, размер шрифта и начертание 

подберите сами (шрифт Arial размер 4 pt). 

Шаг 4. Сделайте активным слой с текстом и дважды выполните команду 

«Создать дубликат строя» после клика правой кнопки мыши по слою. Таким 

образом, у вас будет три слоя с текстом. Для удобства объяснения урока я их 

переименовала в 1, 2 и 3. 
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Установите у среднего слоя (на скриншоте - "2") цвет # 8c8282 

         
А у самого верхнего слоя (на скриншоте "3")) цвет # cabfbf 

Шаг 5. Растрируйте все три текстовых слоя, щелкнув правой кнопкой 

мыши по нужному слою и выбрав из появившегося контекстного меню пункт 

Rasterize Type (Растрировать текст). Теперь отключите видимость всех теперь 

уже бывших текстовых слоев, щелкнув по глазу слева от слоя в палитре слоев. 

Шаг 6. Сделайте активным слой с нашим изображением и выполните 

команду Select >Color Range (Выделение – Цветовой диапазон). 

В одноименном диалоговом окне найдите раскрывающийся список Select 

(Выделить) и выберите там пункт Shadows (Тени). 

 

Нажмите Ok (Да). Вы увидите, что на 

изображении под выделение попали все темные 

участки, что нам собственно и нужно. Инвертируем 

выделение командой Select >Inverse (Выделение - 

Инверсия). Сделаем видимым первый текстовый слой, 

перейдем на него и нажмем Delete для очистки от 

лишних пикселей. Нажмите CTRL+D для отмены 

созданного выделения. Вот что должно получиться. 

Шаг 7. Теперь проделайте ту же операцию 

только для Midtones (Средние тона)  и слоя «2», затем 

заполненных текстом разного цвета. Цвета эти 

Highlights (Света) и слоя «3». Мы создали три слоя 

соответствуют оттенкам, которые мы загружали 

посредством Color Range (Цветовой диапазон). По 

завершении отключите видимость слоя с картинкой и 

создайте новый слой, заполненный белым цветом под 

слоями с текстом, и получите желаемый результат.  

Качество готового рисунка будет тем выше, чем 

удачнее Вы поработаете в Шаге 1. Также попробуйте 

манипулировать в Шаге 3 с опциями шрифта, 
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вставляемого в картинку (тип, размер, «жирность», 

межстрочный интервал). 

 

 

 

Практическая работа 3.2  

Подготовка и печать изображений 

Норма времени: 8 часов 

Цель работы: познакомиться с основными законами  установки цвета, 

способов сохранения изображений, файловыми форматами и размерами файла, 

параметрами преобразования.  

Научиться создать и подготовить макет к печати, подготавливать кадры, 

сохранять изображения и выводить их на печать, используя знания основных 

приемов и способов печати изображений ,параметров принтера. 

Студент должен знать: 

Установки цвета. 

Способы сохранения изображений Файловые форматы и размеры файла. 

Параметры преобразования. Способы печати изображений 

Параметры принтера. 

Студент должен уметь: Создать и подготовить макет к печати 

Подготавливать кадры. Создавать кадры, настраивать временную 

последовательность. Сохранять изображения и выводить их на печать. 

 Задание: Создание и подготовка макета к печати. 

Методические рекомендации по выполнению работы: Требования к 

макетам, предназначенным для печати на широкоформатных принтерах 

Готовые изображения принимаются в форматах: 

1. TIF (Adobe Photoshop) – растровые.  

2. Ai (Adobe Illustrator) - векторные 

1.1 Растровые изображения. Независимо от количества dpi при печати, 

разрешение представляемого изображения должно быть в пределах от 18,75 до 

75 dpi , причем конечный файл не должен превышать 200 Mb. Макет должен 

быть представлен в масштабе 1:1. В случае, если программа (Photoshop 5.0-5.5), 

в которой осуществляется верстка, не поддерживает требуемого размера 

изображения, можно уменьшить макет пропорционально в 2 раза. При этом 

количество dpi должно быть увеличено в пропорции 1:2, т.е. если размер 

изображения уменьшается в 2 раза, то количество dpi должно быть увеличено в 

4 раза (например: макет размером 60 х 30 сантиметров в формате TIFF при 

разрешении 370 dpi занимает около 150-180 Mb.). Файл НЕ ДОЛЖЕН 

содержать дополнительных альфа-каналов и путей. При сохранении файла в 

формате TIF не допускается использование опции LZW Compression. 

2.1 Векторные изображения. Все шрифты должны быть переведены В 

КРИВЫЕ. Не допускается использование функции overprint. Макет, 

оригинальный размер которого превышает 200 см. по большей стороне должен 

быть уменьшен пропорционально в масштабе 1:10. Растровые изображения 

должны быть ПОДЛИНКОВАННЫМИ, а не внедренными в векторный формат, 
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и представлены дополнительно, в соответствие с требованиями, 

предъявляемыми к изображениям растровой графики. Подлинкованные 

изображения в формате EPS - не принимаются. 

3. Все цвета, используемые в макете, должны быть представлены в 

цветовой схеме CMYK. Максимальная сумма составляющих по каналам CMYK 

в каждой точке макета не должна превышать соответственно: для печати на 

банерной ткани, самоклеющейся пленке и сетке - 240, бумаге - 220 (total ink). 

Для получения качественного черного цвета при печати на банерной ткани, 

сетке и самоклеющейся пленке предпочтительно составной (C40 M40 Y40 

K100) черный цвет, а при печати на бумаге (C5 M5 Y5 K100). 

В соответствие с калибровкой нашего печатного оборудования под 

стандарт офсетной печати, при выборе цветов Вы можете ориентироваться на 

"веер" PANTONE process coated EURO. Однако при этом необходимо 

учитывать, что цветовой охват печатных машин для широкоформатной печати 

значительно меньше цветового охвата процесса офсетной печати и не все цвета 

PANTONE "веера", особенно "чистые" из растрового формата TIF могут быть 

напечатаны корректно. Это означает, что даже задав в TIF-файле значения 

CMYK, например: (C0 M0 Y100 K0), (т.е. 100-процентный желтый цвет), такой 

цвет будет напечатан с использованием всех триадных красок. Это вызвано 

тем, что система управления цветом будет имитировать цвет триадных красок 

офсетной печати. Это позволяет добиться максимального приближения цвета 

готовой продукции к желаемой Вами цветовой гамме PANTONE process coated 

EURO. Печать "100-процентных" цветов возможна только из файлов, 

предоставленных в формате Ai (Adobe Illustrator). 

4. Принимаемые макеты должны иметь однозначные технические данные 

для печати: размер, материал, качество, тираж, а также четкие указания к 

послепечатным работам (пробивка люверсов, сварка, и т.д.). 

5. Макеты, в форматах CorelDRAW и Macromedia FreeHand - не 

принимаются. 

6. Носители: CD; Floppy 1,4 Mb. 

Этапы выполнения задания 1: Откройте изображение, которому нужно 

добавить 1 или более капелек.  Добавьте новый слой, кликая на него в палитре 

Layers и сделайте круглое выделение с помощью Elliptical Marquee Tool. Не 

обязательно делать идеально ровный круг. Это придаст вам уверенности, что 

конечный результат будет похожим на наш вариант.  

После окончания этого урока вы конечно же можете 

поэкспериментировать с настройками. Теперь нажмите букву D на вашей 

клавиатуре, чтобы задать основной цвет черный, а фоновый - белый. 

При активном выделении выберите Gradient Tool и возьмите линейный 

градиент (В) в панели настроек наверху. 
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Если все нормально, то мы увидим в окошках предпросмотра следующие 

настройки. Удостоверьтесь, что градиент переходит из черного в белый. Если 

нет, то посмотрите, чтобы опция Revers (С) была отключена. Если вы не видите 

черно-белый градиент, то дважды нажмите на градиенте в панели (A), выберите 

нужный градиент, щелкните OK. 

Сейчас мы нарисуем градиент слева 

направо.  

Начинаем от красной точки и тянем 

градиент до синей точки. 

После того как сделали, снимите выделение - нажмите Сtrl + D или 

выберите в меню Select / Deselect.  

Добавьте прозрачности. Поменяйте 

blending mode (режим смешивания слоя) на 

панели Layers (Слои) на Overlay (Перекрытие).  

Добавьте слою стиль, для чего кликните на 

букве "f" на панели Layers.  

Для начала выберите Drop Shadow (Тень) и установите настройки. 

Выберите Inner Shadow (Внутренняя тень) и установите такие параметры; 

                                             
Помните, что вы всегда вправе немножко менять настройки - это все 

зависит от того, какой у вас фон и размер капельки. Теперь добавим блик 

нашей капле. Нажмите букву X на вашей клавиатуре, чтобы переключиться на 

черно-белые цвета; основной цвет - белый.  Теперь выберите жесткую кисть 

размером в 6 px (вообще размер зависит от размера вашей капли) и капните 

краской на верхнем левом углу вашей капли. Рекомендуется создавать 

отдельные слои и под капельку и под блик. При увеличении или уменьшении 

старайтесь соблюдать пропорции. Попробуйте изменить размер капли, с 

помощью фильтра Liquify Tool (меню Filter/Liquify /Фильтр - Пластика) и 

используя Forward Warp Tool. Техника по созданию капли, которая 

описывается в этом уроке, не изменяет фон под каплей. Хотя в природе капля 

работает как увеличительное стекло, и по идее фон под каплей должен быть 

слегка увеличен.  Если вы хотите придать части листа под каплей эффект 

увеличения, то вам следует при нажатой клавише Ctrl кликнуть на слое с 

каплей - вокруг капли появиться выделение.  

Теперь вам нужно активировать фоновый слой (дважды щелкните по 

слою, если он закрыт). Затем направляйтесь в меню, выберите Filter/Liquify... 

(как уже делали раньше) и возьмите Bloat Tool чтобы увеличить фон одним или 

двумя щелчками мыши на выделенной части фона. После увеличения участка 
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фона, вы уже не сможете свободно перемещать каплю, так как увеличенная 

часть останется на месте. 

 
 

Этапы выполнения задания 2: Откройте изображение, которое будете 

использовать для работы. Это любое лицо и изображение любого текстурного 

материала. Наложите текстуру на объект в новом слое.  

Отразим нашу текстуру по вертикали, выполняем Edit - Transform – Flip to 

Vertical (Редактирование – Трансформирование - Отразить по вертикали) и 

установим непрозрачность для этого слоя 50% 

                          
Затем, изменим способ наложения для этого слоя. Автор использовал способ 

наложения Multiply (Умножение) с непрозрачностью 80%. После этого 

применяем Edit - Transform - Warp (Редактирование – Трансформирование - 

Деформация) для трансформирования текстуры, как показано на картинке. Эта 

текстура закроет лицо и нам потребуется еще одна, для того чтобы закрыть 

шею. Скопируйте текстуру на Ваш холст еще раз и измените способ наложения 

слоя также на Multiply (Умножение), непрозрачность 80%. После этого немного 

уменьшите размер изображения в этом слое и выполните Edit - Transform - 

Warp (Редактирование – Трансформирование - Деформация). 

                                      
Сейчас объединим два слоя с текстурой в один и удалим все лишние 

детали текстуры, выходящие за рамки кожи портрета. Для этого, отключите 

видимость верхнего слоя и активируйте нижний слой с текстурой. Выберете 

инструмент Eraser Tool  (Ластик) с круглой мягкой кистью около 20 px и 
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обработайте края, чтобы получить данное изображение. Теперь обработайте его 

края таким же образом. 

                                      
Объедините эти два слоя в один и измените  способ наложения на 

Multiply (Умножение) также, как делали это ранее. Воспользуйтесь 

инструментом Sharpen Tool (Резкость) с мягкой круглой кистью около 400 px 

и добавьте немного резкости. Удалим область глаз из текстуры. Для этого 

используем инструмент Eraser Tool (Ластик) с мягкой круглой кистью около 

10 px. 

                                     
Придадим нашей текстуре эффект некоторой объемности. Для этого 

эффекта  используем инструменты: 

Dodge Tool (Осветлитель) Диапазон: Highlights (Яркие тона, Света), Exposure 

(Экспозиция, Выдержка): 35% и Burn Tool (Затемнитель) Диапазон: Shadows 

(Тени), Exposure (Экспозици я): 40%. Сделайте одни части лица более 

светлыми и наложите тени на более темные участки. Постарайтесь придать 

изображению большую реалистичность. Теперь добавим одежде этого человека 

немного резкости. Используем инструмент Sharpen Tool (Резкость) Размер: 

90 px, Режим: Нормальный, Интенсивность: 50% . 

                            
Выполним Select - Load Selection (Выделение - Загрузить выделение) 

чтобы создать выделение как на картинке ниже, после этого создадим новый 

слой (поверх всех) и зальем выделение цветом #331e01. Удалите выделение 

(Ctrl+D) и измените способ наложения слоя на Color (Цветность). 



 47 

                               
После создания нового цвета кожи человеку давайте добавим немного 

холодного оттенка его лицу. Для придания этого эффекта выбираем Elliptical 

Marquee Tool (Овальная область) (Растушевка: 100 px) и создаем выделение 

как на картинке.  Затем применяем (не снимая выделения) Image - Adjustments - 

Hue/Saturation (Изображение – Коррекция - Цветовой тон/Насыщенность). 

                                                   
Убираем выделение (Ctrl+D). Вот что у нас должно было получиться.  

В завершение урока, используя инструмент Eraser Tool (Ластик) с мягкой 

круглой кистью размером около 100 px можно немного подровнять нижнюю 

часть лица и шею, но совсем немного. Оцените полученный результат. 

                              
 

Раздел 4. ОСНОВЫ СОЗДАНИЯ И РЕДАКТИРОВАНИЯ 

 ВЕКТОРНЫХ ИЗОБРАЖЕНИЙ 

Практическая работа 4.1 

 Знакомство с Illustrator. Интерфейс. Контуры и фигуры.  

Операции с объектами 

Норма времени: 8 часов 

Цель работы: познакомиться с Illustrator, интерфейсом программы.  

Студент должен знать: 

Меню. Параметры документов. Информацию о документе. Инструменты, 

интерфейс программы, контуры и фигуры, операции с объектами. 

Студент должен уметь: 

Пользоваться палитрами. Производить операции с файлами.  Просматривать и 

масштабировать документ. Создавать точные и произвольные контуры. 
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Редактировать контуры по точкам. Корректировать контуры. Создавать и 

корректировать фигуры. Выделять и трансформировать. Производить сложную 

деформацию контура. 

Задание: Выполнение задания на отработку знаний о программе 

Illustrator, интерфейса, работа с контурами и фигурами. Проделать операции с 

объектами 

Методические рекомендации по выполнению работы: Векторное 

изображение. Если в растровой графике базовым элементом изображения 

является точка, то в векторной графике – линия. Линия описывается 

математически как единый объект, и потому объем данных для отображения 

объекта средствами векторной графики существенно меньше, чем в растровой 

графике. Линия – элементарный объект векторной графики. Панель 

инструментов Toolbox программы Adobe Illustrator CS. Она очень похожа на 

панель инструментов в Adobe Photoshop. Начнём описание сверху вниз. 

Основной и наиболее часто используемый инструмент программы — 

Sеlection Tool (V), он предназначен для выделения, перемещения, 

масштабирования и поворота объектов. Когда объект выделен, мы видим рамку 

выделения и её маркеры. Для выделения и редактирования узлов объекта и его 

составных частей предназначены два инструмента они расположены правее 

инструмента ion Tool. Direct Sеlection Tool (A) предназначен для выделения 

и редактирования узлов и сегментов. Чтобы выделить и редактировать узел или 

сегмент основного объекта, нужно воспользоваться инструментом Direct ion 

Tool. При выделении узла, Вы увидите, что он обозначен закрашенным 

маркером; в то время, как все остальные будут окрашены белым цветом. Для 

выделения всего основного объекта мы воспользуемся инструментом Group 

ion Tool. С его помощью можно выделять отдельные объекты в пошаговых 

переходах и группах. Немногие пользуются инструментом Magic Wand Tool 

(Y) чтобы выделять все объекты с динаковой заливкой. Его использование 

может значительно экономить время, избавить от лишней рутины. Чтобы 

выделить сразу несколько узлов всех объектов, советую использовать 

инструмент Lasso Tool (Q). Он работает так же как инструмент выделения 

Lasso в Adobe Photoshop. Основные инструменты рисования размещены 

в группе Pen. Инструмент Pen Tool (P) предназначен для рисования кривых.  

Add Anchor Point Tool (+). С его помощью Вы можете добавлять узлы в уже 

существующем контуре. С помощью инструмента Anchor Point Tool (-) 

можно легко удалять лишние узлы. Convert Anchor Point Tool (Shift+C) 

предназначен для редактирования изгибов контура. В векторных редакторах 

часто приходится работать с текстом. Именно для этих задач предназначена 

группа инструментов Type. Основной инструмент для работы с текстом 

(и Вы наверняка его давно знаете) — Type Tool. С его помощью можно 

создавать два типа текстовых объектов: простой и фигурный. Чтобы создать 

блок фигурного текста достаточно лишь выбрать инструмент Type Tool 

и щёлкнуть в любом месте документа. Текст можно расположить на кривой. 

http://balbesof.net/article/a-10.html
http://balbesof.net/article/a-11.html
http://balbesof.net/article/a-45.html
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Для этого предназначен инструмент Type on a Path Tool. Текст может иметь 

также вертикальным. Для этого предназначены инструменты Vertical Type 

Tool, Vertical Area Type Tool, Vertical Type on a Path Tool. Для создания 

дополнительных элементов, основанных на линии существует группа 

инструментов Line. Инструмент Line Segment Tool предназначен для 

рисования прямых линий под разными углами. Он часто бывает необходим при 

верстке. Arc Tool предназначен для создания изогнутых линий. Для 

редактирования степени кривизны кривой, её типа (открытая, замкнутая) и др. 

можно воспользоваться окном настроек кривой. Вызвать это окно можно 

двойным щелчком мыши на пиктограмме инструмента. Использовать обычное 

перо для рисования спирали не так просто. Для этого используют инструмент 

Spiral Tool. Как видите, рисование спиральных объектов без помощи этого 

инструмента может оказаться трудной задачей. Работая в Adobe Illustrator 

может понадобиться рисовать различные таблицы и сетки. Для этого служит 

инструмент Rectangular Grid Tool. Вызывая окно настроек двойным 

щелчком мыши на пиктограмме инструмента можно задать количество 

столбцов и строчек, размер сетки и другие параметры. Для создания полярной 

сетки служит специальный инструмент Polar Grid Tool. Незаменимыми 

можно назвать инструменты следующей группы. С их помощью можно 

создавать различные геометрические фигуры. Инструмент Rectangle Tool 

(M) не нуждается в представлении. Он служит для построения 

прямоугольников. Для рисования прямоугольников со круглёнными углами 

служит инструмент Rounded Rectangle Tool. Polygon Tool предназначен 

для создания многоугольников. Звёзды с различным количеством вершин 

можно создавать с помощью инструмента Star Tool.  

Любители Adobe Photoshop наверняка хорошо знакомы со стандартным 

эффектом Lens Flare. Его же можно применять и в Adobe Illustrator спомощью 

инструмента Flare Tool. При рисовании Вам могут помочь инструменты 

группы Pencil.Для сглаживания линий используют инструмент Smooth 

Tool. Erase Tool применяется для удаления сегментов. Кривая второго 

порядка не имеет точек перегиба. Прямые линии являются всего лишь частным 

случаем кривых второго порядка. Формула кривой второго порядка в общем 

виде может выглядеть, например, так:  x2+a1y2+a2xy+a3x+a4y+a5=0. Кривая 

третьего порядка. Отличие этих кривых от кривых второго порядка состоит в 

возможном наличии точки перегиба. Именно эта особенность позволяет 

сделать кривые третьего порядка основой отображения природных объектов в 

векторной графике. Все кривые второго порядка, как и прямые, являются 

частными случаями кривых третьего порядка.  

 

http://balbesof.net/article/a-80.html
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В общем случае уравнение кривой третьего порядка можно записать так: 

x3+a1y3+a2x2y+a3xy2+a4x2+a5y2+a6xy+a7x+a8y+a9=0. Таким образом, 

кривая третьего порядка описывается девятью параметрами. Описание ее 

отрезка потребует на два параметра больше. Кривая третьего порядка (слева) и 

кривая Безье (справа). Кривые Безье. Это особый, упрощенный вид кривых 

третьего порядка Векторное изображение масштабируется без потери качества: 

масштабирование изображения происходит при помощи математических 

операций: параметры примитивов просто умножаются на коэффициент 

масштабирования. Изображение может быть преобразовано в любой размер (от 

логотипа на визитной карточке до стенда на улице) и при этом его качество не 

изменится. Векторное изображение можно расчленить на отдельные элементы 

(линии или фигуры), и каждый  редактировать, трансформировать независимо. 

                                                           
Размер файла, как правило, не зависит от размера  изображаемых объектов, но 

зависит от сложности изображения: количества объектов на одном рисунке 

(при большем их числе компьютер должен хранить больше формул для их 

построения), характера заливки - однотонной или градиентной) и пр.  

Векторные файлы имеют сравнительно 

небольшой размер, т.к. компьютер запоминает 

только начальные и конечные координаты 

элементов изображения - этого достаточно для 

описания элементов в виде математических 

формул.  

Понятие «разрешение» не применимо к 

векторным изображениям. Векторные 

изображения: более схематичны, менее 

реалистичны, чем растровые изображения, «не 

фотографичны».  

Применение: 

1. Для создания вывесок, этикеток, логотипов, эмблем и пр. символьных 

изображений; 

2. Для построения чертежей, диаграмм, графиков, схем; 

3. Для рисованных изображений с четкими контурами, не обладающих 

большим спектром оттенков цветов; 

4. Для моделирования объектов изображения;  

5. Для создания 3-х мерных изображений;  

Этапы выполнения задания 
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Создаем новый документ с цветовой документ с цветовой палитрой RGB. 

При помощи инструмента ellipse (L) рисуем круг (для этого надо зажать 

Shift), отключаем обводку и заливаем его зеленым цветом. Потом выбираем 

Direct Selection Tool(A), два раза щелкаем на нижнюю точку на круге и 

вытягиваем вниз. Это будет тело (оно же голова)) осьминога. Копируем 

получившееся тело и вставляем сверху имеющегося. При помощи того же 

Direct Selection Tool сплющиваем снизу и заливаем немного светлым зеленым. 

 

 

 

 

         Создаем несколько небольших эллипсов, заливаем их светло-зеленым 

цветом и помещаем их на "лоб" осьминожке. Это что-то вроде подводных 

веснушек). Потом выделим все, что у нас получилось и сгруппируем (ctrl+G) 

Приступим к рисованию рта. Создаем круг и заливаем его темно-серым. Потом 

рисуем прямоугольник(M), делящий круг вертикально пополам. Выделаем оба 

объекта и в панели Pathfinder выбираем Minus Front. Получили полукруг. 

 

 

 

 

У осьминогов, конечно, не бывает зубов, но у этого будут. Дублируем 

имеющийся полукруг. Рисуем два маленьких пересекающихся кружочка. 

Группируем их ctrl+G и переносим на один из полукругов. Выделяем все и в 

панели Align выбираем Horizontal Align Center -  отцентровать будущие зубки.  
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Не снимая выделения, снова применяем Minus Front из Pathfinder. 

Заливаем первый полукруг белым цветом, помещаем его ЗА темный. 

Получились белые зубки. Чтобы сделать язычок, делаем копию рта, рисуем 

белый кружок, центруем его и выбираем Intersect. Получили язык. Вставляем 

его открытый рот. Закрасим язычок. Зальем его линейным градиентом от 

розового до светло-розового. Далее есть два варианта. В уроке предлагается 

выбрать инструмент Gradient (G) и поменять направление заливки при помощи 

мышки.  Или просто поменять угол в панели Gradient Группируем рот и язык, 

переносим их на голову и центруем при помощи панели Align Приступим к 

рисованию глазок. Создаем черный кружочек.  

И еще два белых поменьше и размещаем как на картинке. Группируем. 

 
          Копируем и помещаем оба глаза на голову. Ставим цвет обводки (stroke) 

зеленым. как тело осьминога. выбираем толщину линии 16pt и закругленные 

концы ( в панели stroke cap->round cap). Выбираем Pen Tool(P) и рисуем ножку. 

Для этого один раз кликнем в любом свободном месте, устанавливая точку 

привязки. Затем кликнем в другом месте и движениями мышки создаем первый 

изгиб ножки. Кликнем в другом месте и делаем второй изгиб ножки. 

  
Потом выбираем получившуюся ножку и делаем Expand. Дублируем ее поверх. 

Зажимаем ALT и перетаскиваем получившуюся копию немного вниз. 

Получается уже три ножки. Закрашиваем последнюю более темным зеленым, 

как низ тела у осьминога. Выделяем две ножки и в панели Pathfinder выбираем 

Intersect. Выделяем все и группируем. Ножка готова. Далее можно копировать 

уже имеющуюся ножку, или рисовать заново. Приступим к созданию фона. 

Нарисуем квадрат и зальем его радиальным градиентом 
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.  

Создаем круг без заливки и обводки. Далее идем в панель stroke и 

устанавливаем weight 400, align stroke to inside, ставим галочку dashed и dash 40. 

Копируем этот круг и вставляем сверху. однако теперь отключаем stroke и 

заливаем градиентом от белого к черному. Выделяем оба круга и в боковом 

меню opacity выбираем "make opacity mask". Рисуем кружочек, заливаем его 

белым, идем в Effect > Distort & Transform > Pucker and Bloat и делаем 

звездочку. Ставим opacity 50%, копируем несколько раз и расставляем на 

картинке. 

                                             
 

 

Практическая работа 4.2 

 Работа с цветом. Редактирование обводок.  

Объекты в документе. Группы и комбинированные контуры 

Норма времени: 8 часов 

Цель работы: Познакомиться с основными законами работы с цветом, 

редактированием обводок. Изучить объекты в документе, группы и 

комбинированные контуры. 

Студент должен знать: Основные атрибуты. Дополнительные атрибуты 

и их возможности. Объектные обводки. Операции с кистями. Способы 

математического описания цвета. Цветовые режимы. Основные приемы 

работы. 

Студент должен уметь: 

Создавать и редактировать градиент. Использовать каталог цветов и образцов. 

Производить автоматические операции с атрибутами. Использовать узорные 

заливки и библиотеки образцов.  

Производить измерения в Illustrator. Производить перекрытие и выравнивание 

объектов. Создавать и выделять группы объектов. Комбинировать контуры. 

Производить действия с контурами. 
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Задание: Ознакомление с основными законами работы с цветом, 

редактированием обводок. Изучение объектов в документе, группы и 

комбинированные контуры. 

Методические рекомендации по выполнению работы:  

Заливка Цветом из 

Образцов. Чтобы залить фигуру 

цветом, откройте панель 

Swatches (Образцы). Выделите 

вашу фигуру и выберите любой 

цвет из предложенных. 

Заливка Цветом При 

Помощи Цветовой Палитры 

Еще один способ заливки 

цветом это двойной клик по Fill 

(Заливка) на панели 

инструментов. Появится окно 

цветовой палитры, и вы сможете 

выбрать ваш цвет. 

 

Меняем Заливку и 

Границы При Помощи Панели 

Управления. Также легко 

изменить цвет заливки, границы, 

а также ширину границы через 

панель управления вверху 

рабочей области. 

Сгибы Границы. Сгибы 

границы определяют начальные и 

конечные точки линий. Это 

применимо только к открытым 

путям.  

Пределы Сглаживания. 

Предел сглаживания сгибы 

определяет метод соединения 

линий в фигуре (с различными 

настройками пределов глаживания) 

Применение Градиента к 

Фигурам. Чтобы применить 

градиент к вашей фигуре, на панели 

инструментов нажмите на пункт 

меню Gradient Fill. 

Откройте панель Gradient and Color (Градиент и цвет). По умолчанию 

градиент стоит на шкале серого. Кликните по иконке Options в углу и 

поменяйте значение на режим RGB. 
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После того как мы перешли в режим RGB 

появится цветовой чарт с бегунком. Выберите 

темно-синий цвет. Проделайте то же самое для 

начальной точки, перейдите в режим RGB и 

поставьте темно-синий цвет. 

                                 
Чтобы добавить новый градиент, кликните правой кнопкой мыши по 

иконке градиента. Цвет проставьте белый. Чтобы удалить его, можно просто 

перетащить границу градиента за пределы панели. Чтобы поменять 

направление градиента, выберите инструмент Gradient (Градиент) из панели 

инструментов. Кликните и протяните в том направлении, в котором вы хотите 

поставить градиент. 

                                 
Радиальный Градиент. Чтобы поставить радиальный градиент, 

поставьте вид градиента на Radial вместо of Linear. Заливка Узором. Чтобы 

сделать сплошную заливку узором, можно выбрать узор из меню Swatches 

(Образцы) 

        
Использование радиального и линейного градиента придает нашим 

работам много реализма. Радиальные узоры могут добавить глубины и объема 

простой окружности, линейные узоры могут быть использованы для придания 

глубины цилиндрам.  

Этапы выполнения задания: 

 

 

 

http://balbesof.net/article/read/illustrator_gradient.html
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Задание еще раз даст представление, что градиент в 

Illustrator, да и в других дизайнерских программах, является 

мощнейшим инструментом в создании реалистичных сцен.  

Урок проделывался в Illustrator CS3, так же возможно 

выполнения на любых версиях программы.  

Создайте инструментом Star Tool звезду. Создавайте ее с зажатой 

кнопкой Shift – для того чтобы звезда не прокручивалась и встала ровно, как 

показано на рисунке. Инструментом Line Segment Tool (\) создайте линии.    

Это буду временные направляющие. 

 
Переключитесь на инструмент Pen Tool (T). И создайте треугольник. 

Теперь можно удалить линии, которые мы создавали ранее. Выделите 

треугольник пройдите в Object\Transform\Reflect… Там выставите параметры 

как показано на рисунке и нажмите кнопку Copy. Состыкуйте полученную 

зеркальную копия с оригиналом. Я закрасил ее другим цветом (для удобства). 

 
Нужно создать такие пары треугольников в каждый угол звезды. Для 

этого копируйте их (Ctrl+c - копировать; Ctrl+v – вставить) и инструментом 

Rotate Tool (R) поворачиваете в нужные стороны, а инструментом Selection 

Tool (V) стыкуйте треугольники. Если где-то треугольники стыкуются 

неплотно, то возьмите инструмент Direct Selection Tool (A) выделите нужную 
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вершину и подтяните их. Звезду, созданную в первой шаге можно удалить, она 

нам больше не пригодится. 

 
Применим для каждого в отдельности треугольника линейный градиент. 

Откройте палитру Gradient (Window\ Gradient Ctrl+F9) и настройте градиент 

согласно рисунка. Как вы заметили на рисунке нет числового значения цветов. 

Выделите нужную точку градиента и выберите инструмент пипетка (Eyedropper 

Tool (I)), и при нажатой кнопки Shift щелкните по нужному цвету на картинки. 

Выделите все созданные фигуры и нажмите Ctrl+G (Object\Group). Теперь, 

когда мы сгруппировали все, в одну звезду, скопируем ее и вставим поверх 

оригинала. Тем самым у нас получиться две звезды одна поверх другой (Ctrl+C 

копировать; Ctrl+F вставить поверх на то же место). 

 
Применим к верхней звезде некоторые параметры. В палитре 

Transparency (Window\ Transparency Shift+Ctrl+F10). Перейдите в 

Effect\Blur\Gaussian Blur (подробности на рисунке). И на последок пройдите в 

Effect\Distort\Diffuse Glow. Граненная звезда готова 

  
 

Раздел 5.  ТЕКСТ. ГЛОБАЛЬНОЕ УПРАВЛЕНИЕ ОБЪЕКТАМИ 

Практическая работа 5.1  

Создание и виды текстовых объектов 

Норма времени: 6 часов 

Цель работы: познакомиться с основными работы с текстами в 

программе, особыми свойствами текстовых объектов. Научиться создавать 

простой текст, текст в области, текст на контуре, вертикальный текст, выделять 

текстовые объекты, переводить текст в редактируемые контуры. 
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Студент должен знать: Атрибуты абзаца. Приемы автоматического 

редактирования текста. Особые свойства текстовых объектов. 

Студент должен уметь: Создавать простой текст. Текст в области. Текст 

на контуре. Вертикальный текст. Выделять текстовые объекты. Переводить 

текст в редактируемые контуры. 

Задание: Выполнение работы по созданию текстовых объектов. 

Методические рекомендации по выполнению работы: Вводим имя 

документа и выставляем свои значения параметров. Выбираем инструмент 

текста. И вводим текст 

           

  

 Для того, чтобы сделать текст цветным, нужно просто щелкнуть по 

цвету. Но мы попробуем залить текст градиентом. Для этого нажимаем кнопкой 

мыши на определенный цвет и перетягиваем его на шкалу градиента.  

  

 И текст наш будет залит выбранным градиентом. Давайте, добавим 

цветов к шкале градиентов и подрегулируем ползунки цветов. И получаем 

другой рисунок цветов.  Сохраняем наш результат. 

 

 
Этапы выполнения задания: Шаг 1. Выберите шрифт и при помощи 

инструмента Текст Type Tool (T) создайте какую-нибудь надпись. Уберите 

заливку и обводку у текста. Если данная панель у вас не отображена, то её 

можно включить в меню Window > Appearance (Окно > Внешний вид) или 

просто нажав сочетание клавиш Shift+F6.  
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Шаг 2. В выпадающем меню палитры Appearance выберите пункт Add New Fill 

(Добавить новую заливку). Затем кликнете в появившейся строке новой заливки 

на иконку выбора цвета и выставьте заливку линейным чёрно-белым 

градиентом. 

Шаг 3. На этом шаге добавим ещё два цветовых маркера градиенту для 

создания металлического эффекта. Чтобы добавить 2 маркера, кликнете в 

палитре Gradient под цветной полосой градиента приблизительно в середине 

два раза. Итак, всего у нас получилось 4 цветовых маркера. Задайте для них 

следующие цвета (слева направо): первый маркер — 70% чёрного; второй — 

белый; третий — 100% чёрный; четвёртый — 30% чёрного. 

Шаг 4. После создания маркеров, откорректируем немножко сам 

градиент. В палитре настроек градиента задайте для него угол поворота -90º. 

Затем выберите белый цветовой маркер и укажите для него место положения 

45%. Для чёрного маркера укажите положение 50%. И последнее: для маркера 

распространения цвета (они располагаются НАД полоской градиента) между 

чёрным цветовым маркером и 30% чёрным задайте положение 35%. 

 
Шаг 5. Cнова идём в палитру Appearance и создаём ещё одну заливку 

Add New Fill. Выбираем эту заливку в палитре и задаём для неё линейный 

градиент от 32% чёрного до 100% чёрного. Проверьте, чтобы угол градиента 

был -90º.  

Шаг 6/ Не снимая выделения со второй заливки, идём в меню Effect > 

Path > Offset Path (Эффект > Путь > Сместить путь). В появившемся 

диалоговом окне задайте величину смещения 1 рх. Чтобы отредактировать этот 

эффект, то кликнете в палитре Appearance на маленький треугольничек возле 

второй заливки — в раскрывшемся списке вы найдёте применённый эффект. 

Кликнете на нём мышкой, чтобы отредактировать значение смещения. 



 60 

  
Шаг 7. Выделите полученную копию заливки (она находится в самом низу 

списка заливок) и кликнете на эффекте смещения для неё. В диалоговом окне 

измените смещение на 2 рх. Затем отредактируйте градиент для этой заливки: 

первый цветовой маркер — 10% чёрного; второй — 60% чёрного. 

  
Шаг 8. Для выполнения последующих шагов неплохо добавить тёмный фон, 

чтобы мы могли более явно видеть полученный эффект. Нарисуйте 

прямоугольник инструментом Rectangle tool (M) и переместите на задний план 

Ctrl+Shift+[. 

 
Шаг 9. Начните с создания ещё одной заливки для текста в палитре Appearance 

и убедитесь, что она выделена и расположена в самом верху списка. Затем идём 

в меню Effect > Convert to Shape > Ellipse (Эффект > Преобразовать в фигуру 

> Эллипс). В появившемся диалоговом окне выделите вариант Absolute и 

задайте длину и ширину равными 50рх. 
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Шаг 10. Не снимая выделения с последней созданной заливки, измените тип 

градиента на радиальный. Для первого маркера задайте белый цвет и 

прозрачность 80%, второй маркер — тоже белый, но с прозрачностью 0%. 

   
Шаг 11. Вы можете разместить вспышку там, где вам захочется. Чтобы это 

сделать, убедитесь, что последняя заливка всё ещё выделена в палитре 

Appearance. Затем идём в меню Effect > Distort & Transform > Transform 

(Эффект > Искажение и Трансформация > Трансформация) и в появившемся 

диалоговом окне эффекта измените смещение по горизонтали и вертикали так, 

как вам нравится. Чтобы сразу видеть результат применения эффекта, включите 

галочку предпросмотра Preview в этом окне. 

 
Шаг 12. Не снимая выделения с последней заливки в палитре Appearance, 

нажмите в этой палитре кнопку Duplicate Selected Item.  Выделите последниюю 

полученную заливку и нажмите на маленький треугольничек слева от заливки, 

чтобы раскрыть весь список применённых эффектов. Кликнете на применённом 

эффекте Эллипс и измените значения длины и ширины на 25 рх. 

  
           Шаг 13. Продолжаем работать с последним элементом (проверьте, чтобы 
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он был выделен в палитре) и идём в меню Effect > Distort & Transform > Zig Zag 

(Эффект > Искажение и Трансформация > ЗигЗаг).  

В диалоговом окне эффекта ЗигЗаг задайте размер 10 рх и параметр 

Ridges задайте равным 2 (величина параметров может варьироваться в 

зависимости от размера вашего текста, поэтому включите галочку 

предпросмотра и поэкспериментируйте с параметрами настройки этого 

эффекта).  

Шаг 14. Выделите текст, с применённым эффектом металла и нажмите в 

палитре Graphic Style (Графический стиль) кнопку New Graphic Styles (Новый 

графический стиль). Теперь можете выделять любой текстовый элемент или 

любой другой объект и просто задавать для него в палитре Графический стиль 

вами созданный металлический стиль.   

   
Внизу приведены варианты применения стиля к различным шрифтовым 

композициям и просто объектам. 

 
 

Практическая работа 5.2 

 Представления объектов. Операции с кистями 

Норма времени: 6 часов 

Цель работы: познакомиться с основными кистями, способами 

редактирования представлений, графическими стилями, понятием слой. 

Научиться создавать слои, редактировать, применять графические стили, 

связывать стили и объекты. 

.Студент должен знать: 

Кисти. Способы редактирования представлений. Графические стили. Связь 

стиля и объекта. Понятие слой. Слои и представления объектов. 

Студент должен уметь: 

Создавать слои, редактировать, применять графические стили, связывать стили 

и объекты. 
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Задание: Редактирование представлений, работа с кистями. 

Методические рекомендации по выполнению работы: Операции с 

кистями. Выделите его и щелкните на кнопке New (новый) в нижней части 

палитры или выберите команду New Brush (новая кисть) меню палитры. 

Программа откроет окно определения типа создаваемой кисти (рис. 6.28). 

Установите требуемый переключатель и щелкните на кнопке OK. Откроется 

окно редактирования кисти соответствующего типа. Ниже рассматривается 

процесс создания и редактирования кистей разных типов. Перетаскивание 

выбранного объекта на палитру Brushes (кисти) равносильно выбору команды 

New Brush (новая кисть) меню палитры и также приводит к открытию 

диалогового окна определения типа кисти. Выберите команду New Brush (новая 

кисть) меню палитры или щелкните на кнопке New (новый). В окне New Brush 

(новая кисть) установите переключатель New Calligraphic Brush (новая 

каллиграфическая кисть).  

Щелкните на кнопке OK. Откроется окно Calligraphic Brush Options (параметры 

каллиграфической кисти), которое описывает все свойства каллиграфической 

кисти (рис. 6.30). 

   
В поле Name (имя) введите имя для кисти. По умолчанию программа 

предлагает имя Calligraphic Brush 1 (каллиграфическая кисть 1). В полях 

просмотра показаны форма элемента кисти (слева), а также его положение и 

размер (справа). Кисть может иметь форму круга или эллипса. Чтобы 

установить форму, щелкните мышью на одной из черных точек в поле 

просмотра слева и перетащите ее к началу координат. Форма кисти станет 

эллиптической. Другой способ задания формы -- установка значения в поле 

Roundness (округлость). Для круглой кисти оно равно 100%. Чем более 

сплюснута кисть, тем меньше значение параметра Roundness (округлость). 

Форма кисти отображается и в поле просмотра справа. Если кисть 

эллиптическая, она может располагаться под наклоном. Угол наклона можно 

ввести в поле Angle (угол). Для редактирования, например, созданной вами 

каллиграфической кисти щелкните на ее образце и выберите команду Brush 

Options (параметры кисти) меню палитры. Если в документе уже есть объекты с 

данной обводкой, увидеть их изменение в зависимости от задаваемых значений 

можно, установив флажок Preview (просмотр). Отредактировав кисть, щелкните 

на кнопке OK. Если в документе есть объекты с этой обводкой, откроется 

следующее диалоговое окно. 
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Выделение и редактирование контура с кистью. Для выделения контура с 

обводкой кистью щелкните на любом участке обводки. Будет выделен только 

контур (рис. 6.23). Обводка кистью не рассматривается программой как объект 

и не редактируется обычным способом. Выделенный контур можно 

перемещать и трансформировать как обычный. Вместе с контуром 

трансформируется и обводка. Если объект имеет обводку Scatter (разброс), то 

объекты обводки могут располагаться на значительном удалении от самого 

контура, однако и они изменяют положение вместе со своим контуром. 

 
Выделите показанный на рисунке контур с обводкой кистью.  

1.  Перейдите к инструменту Free Transform (свободное 

трансформирование) и поверните объект.  

2.  Переместите объект. Обводка последует за своим контуром. Можно 

подвергать объект любым трансформациям, при этом обводка будет следовать 

за своим контуром. 

При масштабировании контура обводка кистью может масштабироваться 

вместе с ним или оставаться неизменной. Масштабирование включается и 

выключается, как и для обычной обводки, установкой флажка Scale Strokes and 

Effects (масштабировать обводки и эффекты) в группе параметров General 

(основные) диалогового окна Preferences (настройки), диалогового окна 

инструмента Scale (масштаб) и меню палитры Transform (трансформирование). 

Если флажок снят и обводка не масштабируется, количество объектов кисти 

Scatter (разброс) или Pattern (узор) зависит от длины контура после искажения. 

1. Создайте две копии объекта с обводкой Scatter (разброс). Выберите 

инструмент Shear (наклон) и наклоните один из объектов, чтобы длина контура 

объекта заметно изменилась Установите флажок Scale Strokes and Effects 

(масштабировать обводки и эффекты) и трансформируйте второй объект 

 
Искажение контура (а) с масштабируемой (б) и немасштабируемой (в) 

обводкой Scatter 

2. Снова снимите флажок. Создайте два объекта с обводкой Pattern (узор). 

Инструментом Direct Selection (частичное выделение) выделите одну точку на 

контуре. Перемещая выделенную точку, исказите контур Исказите второй 
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объект с установленным флажком Scale Strokes and Effects (масштабировать 

обводки и эффекты). 

 
 

Этапы выполнения задания: Шаг 1. Одно из самых распространенных 

средств для создания различных эффектов контура является Art Brush. Давайте 

посмотрим, как это делается. Берем Ellipse Tool (L) и создаем окружность. Для 

того чтобы у вас получилась идеальная окружность удерживайте Shift во время 

ее создания и Opt/Alt +Shift, что зафиксировать ее центр. Теперь берем Direct 

Selection Tool (A) и вытягиваем правую точку окружности, удерживая клавишу 

Shift. Не снимая выделения с этой точки, конвертируем ее из гладкой в угловую 

 
Мы получили базовую форму для Art Brush. 

Шаг 2. Перенесем созданную форму в палитру Brushes и сохраним новую 

кисть как Art Brush. В открывшемся диалоговом окне пока не будем делать 

никаких изменений, нажимаем OK. 

 
Шаг 3. Теперь при помощи Pen Tool (P) создадим какой-нибудь контур и 

применим к нему созданную кисть. Как и следовало ожидать, форма кисти 

равномерно растянулась по всему контуру. Угадать заранее какой вид будет 

иметь кривая после применения кисти практически невозможно. Поэтому 

приходится редактировать исходную форму, чтобы добиться нужного 

результата. В Adobe Illustrator CS5 появилась возможность создавать Art 

Brushes, которые будут растягиваться неравномерно.  

 
Шаг 4. Двойной клик по миниатюре кисти в палитре Brushes вызывает 

диалоговое окно с ее параметрами. Выбираем Stretch Between Guides. Эта опция 

позволяет нам устанавливать участок кисти, который будет растягиваться и 

участки, которые будут оставаться неизменными. Длину этих участков можно 

задавать точно при помощи цифровых значений или перемещая направляющие 
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в окне с изображением кисти Нажимаем OK, затем Apply to Strokes в новом 

диалоговом окне. 

 
На рисунке ниже показана стандартная Art Brush (слева) и обладающая новыми 

свойствами (справа). Как практик замечу, что именно правая кисть часто нужна 

в роботе (стебельки, ветки, волосы, первое, что приходит в голову). 

Шаг 5. Теперь давайте создадим более сложную кисть, которая должна 

обладать описанными выше свойствами. Создадим змею, которая может быть 

использована как элемент орнамента или другой графики. Начнем с головы. 

Берем Rectangle Tool ® и создаем прямоугольник. Перемещая при помощи 

Direct Selection Tool (A) вершины прямоугольника приводим его к виду 

неправильной трапеции. 

 
Шаг 6. Конвертируем все его угловые точки в гладкие и при помощи Pen Tool 

(P) добавляем к контуру две новые точки A и B. Управляя точками и их 

ручками, создаем форму головы змеи в профиль. 

 
Шаг 7. Берем Ellipse Tool (L) и создаем глазницу, теперь берем Pen Tool (P) и 

создаем кривую линию – это жало змеи. Устанавливаем профиль и толщину 

для жала змеи в палитре Stroke. 

 
Шаг 8. Берем Ellipse Tool (L) и создаем глаз, теперь берем Pen Tool (P) и 

создаем форму зрачка.  

Шаг 9. Пришло время заняться хвостом змеи. Берем Pen Tool (P) и создаем 

хвост в виде треугольника, как это показано на рисунке ниже. При помощи Pen 

Tool (P) добавляем к контуру две новые точки A и B и немного смещаем их от 

осевой линии хвоста. 
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Конвертируем эти точки из угловых в гладкие. На этом создание формы кисти 

закончено. 

 

Шаг 10. Переносим змею в палитру Brushes и устанавливаем положение 

направляющих в диалоговом окне.  

Шаг 11. Применим созданную кисть к какому-нибудь красивому контуру, 

например к спирали. 

 
Двойной щелчок по этой кисти в палитре Brushes и редактируем параметры в 

диалоговом окне, одновременно наблюдая за изменениями. 

 
Вы также можете управлять распределением толщины хвоста вдоль контура, 

перемещая вторую вертикальную направляющую в диалоговом окне Art Brush 

Options. Смотрите, что было бы, если бы мы применили к контуру обычную Art 

Brush. 

 
 

 

Раздел 6.  РАСТРОВЫЕ ИЗОБРАЖЕНИЯ И ЭФФЕКТЫ. 

СПЕЦИАЛЬНЫЕ ОБЪЕКТЫ ILLUSTRATOR 

Практическая работа 6.1  

Растровая графика. Форматы файлов и их параметры.  

Растеризация объектов 

Норма времени: 8 часов 

Цель работы: познакомиться с основными законами работы с 

растровыми фильтрами и эффектами. Изучить фильтры, преобразующие 

растровые изображения в объектные.  
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Студент должен знать: Растровые фильтры и эффекты. Фильтры, 

преобразующие растровые изображения в объектные.  

Студент должен уметь: Трассировать объекты. 

Задание: Работа по  растеризации объектов 

Методические рекомендации по выполнению работы: Растровые 

изображения очень похожи на мозаику. В этой технике изображение 

формируется из мелких одноцветных элементов, стекол. Если отойти от 

мозаичного панно достаточно далеко, отдельные стекла становятся 

неразличимо малы и изображение кажется однородным (continuous tone). Все 

изображение разбивается на мелкие ячейки, каждая из которых получает 

усредненный по занимаемой площади цвет. При работе с изображением 

компьютер "запоминает" всю эту таблицу и цвет каждой ее ячейки. 

В Adobe Illustrator подобная операция проделывается при экспорте 

иллюстраций в растровые форматы и при создании копии ее фрагментов в виде 

растровых изображений с помощью команды Rasterize (Растрировать) из меню 

Object (Объект). Более подробно эта команда рассматривается ниже.  

Такой простой способ кодирования обеспечивает и легкость его автоматизации 

с помощью сканеров. Основным узлом сканера является линейка из 

светочувствительных элементов. Она помещается на оригинал (рисунок, 

фотографию, слайд и т. п.), а измеряемый каждым ее элементом цвет заносится 

в соответствующий столбец таблицы. При перемещении линейки вдоль 

изображения она измеряет цвета через равные расстояния. Эти измерения 

заносятся в строки таблицы. В результате в таблице оказывается точный 

снимок оригинала в цифровой форме. Каждая ячейка таблицы называется 

точкой, а вся таблица - растровым изображением.  

Монитор тоже является растровым устройством. Его экран покрыт 

прямоугольной сеткой из точек люминофора. При демонстрации изображения 

кодированная информация визуализируется с помощью операции, обратной 

сканированию. Каждой точке изображения ставится в соответствие точка 

люминофора, называемая пикселом. Пиксел принимает цвет соответствующей 

ему точки изображения. Поэтому точку цифрового изображения часто 

отождествляют с пикселом и говорят, что растровое изображение состоит из 

пикселов.  

Чтобы представить себе, сколько места на экране монитора займет 

изображение известного размера, надо знать, сколько пикселов монитора 

приходится на единицу длины. Такая величина имеет собственное название - 

разрешение - и измеряется в пикселах на дюйм (pixel per inch, ppi). Величина 

разрешения обязательно сохраняется в файлах изображений и используется 

программами верстки и подготовки иллюстраций. Использование изображений 

с индексированным цветом в Интернете сложилось исторически и обусловлено 

их небольшими размерами и скромными возможностями персональных 

компьютеров и линий связи в то время, когда World Wide Web начинал 

формироваться. Индексированные цвета несут в себе и ряд потенциальных 

проблем. Компьютеры разных платформ используют различные системные 

палитры. Поэтому изображения, которые выглядят хорошо на вашем Macintosh, 
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вполне возможно, приведут в ужас пользователя, просматривающего Web-

страницу на компьютере PC. Более того, даже разные броузеры могут 

отображать индексированные изображения по-разному. С другой стороны, парк 

компьютеров все время обновляется, и возможности видеосистем все реже 

лимитированы 256 цветами. Поэтому для индексированных изображений на 

Web-страницах все чаще используется так называемая адаптивная (adpative) 

палитра. Она автоматически создается программами обработки изображений 

при переводе полноцветных изображений в индексированные и содержит 

наиболее характерные цвета именно этого изображения. Качество изображений 

с адаптивной палитрой существенно выше, чем со стандартной палитрой 

броузеров, но их правильное отображение на компьютерах с 256-цветной 

видеосистемой гарантировать нельзя. 

Ниже приведен список форматов файлов для растровых изображений, 

поддерживаемых Adobe Illustrator, и указаны особенности их импорта и 

экспорта. Кроме специализированных растровых форматов рассмотрены 

универсальные форматы EPS и PDF, способные хранить как растровые, так и 

векторные изображения. 

    
Вариант формата (Method (Формат)): стандартный (Baseline ("Standard")), 

оптимизированный (Baseline ("Optimized")) или прогрессивный (Progressive). 

Оптимизированные файлы имеют наименьший размер. Наибольшие размеры 

имеют изображения с прогрессивной разверткой. Они широко используется на 

Web-страницах. Броузеры демонстрируют такие JPEG- файлы, постепенно 

увеличивая деталировку (рис. 9.6). Читатель может оценить, требуется ли ему 

детальное ознакомление с изображением, не дожидаясь его окончательной 

загрузки. 

 
Количество шагов развертки задается в списке Scan (Чередование строк) и 

может принимать значения 3, 4 или 5. Разрешение изображения задается в 

области Resolution (Разрешение) с помощью списка Depth (Глубина). Он 

предлагает наиболее типичные варианты, рассчитанные на электронное 

распространение (72 dpi), печать на офисном принтере (150 dpi) и 

типографскую печать (300 dpi). Если вам требуется какое-то иное значение, 
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выберите в списке вариант Custom (Заказное) и в находящемся ниже 

одноименном поле введите требуемое разрешение. Использование сглаживания 

(Anti-Alias (Сглаживание)).Генерация карты ссылок (Imagemap (Карта ссылок)). 

Если флажок установлен, то становится доступен переключатель, 

определяющий тип карты: обрабатываемая клиентом или сервером. В 

отдельном поле указывается условное имя карты ссылок. По умолчанию оно 

совпадает с именем документа Illustrator. 

 
Палитра Links (Связи) содержит список всех связанных и внедренных файлов и 

показывает текущее состояние связей. По этим признакам выделяются 

следующие режимы отображения связей в палитре: 

Show All (Показать все). Устанавливает отображение в списке всех связанных и 

внедренных файлов. 

Show Missing (Показать неверные). Отображаются исключительно неверные 

ссылки на связанные файлы. Связь может быть нарушена в результате 

удаления, перемещения или переименования внешнего файла. Это 

исключительно полезный режим для финального контроля целостности 

иллюстрации. Нарушенные связи в палитре Links (Связи) помечаются особой 

пиктограммой в виде вопросительного знака. 

Show Modified (Показать изменившиеся). Не менее полезный для контроля 

режим отображения. Он устанавливает отображение в палитре только 

измененных файлов. Если вы модифицировали связанный файл в другой 

программе, то его вид в иллюстрации не будет соответствовать новому 

состоянию. Данный режим позволяет легко обнаружить такие ситуации. 

Устаревшие связи помечаются в палитре Links (Связи) пиктограммой с 

изображением восклицательного знака. 

Show Embedded (Показать внедренные). Устанавливает отображение в палитре 

только внедренных файлов. 

В зависимости от вашей задачи установите подходящий режим 

отображения, выбрав соответствующую команду в меню палитры Links 

(Связи). Возможно, наиболее удобно всегда видеть в палитре полный список, 

но отсортированный по состоянию связи или типу внешних файлов. В меню 

палитры Links (Связи) имеются три варианта сортировки, действующие 

совместно с перечисленными выше режимами отображения: 

Sort by Name (Сортировать по имени). Сортировка по имени файла. 

Sort by Kind (Сортировать по типу). Сортировка по типу файла. 
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Sort by Status (Сортировать по состоянию). Сортировка по состоянию связи с 

внешним файлом. 

 
На растровые изображения действует часть фильтров, которые вы ранее 

использовали для объектов: 

Adjust Colors (Настроить цвета). Настройка цветового баланса цветных 

изображений. 

Convert to CMYK (Преобразовать в CMYK). Перевод цветных RGB-

изображений в цветовую модель CMYK. 

Convert to RGB (Преобразовать в RGB). Перевод цветных CMYK-изображений 

в цветовую модель RGB. 

Convert to Grayscale (Преобразовать в градации серого). Перевод цветных 

изображений в полутоновые. 

Invert Colors (Негатив). Инвертирование цветов изображений, получение 

негатива. 

Saturate (Изменить насыщенность). Регулировка насыщенности цветов 

изображения. 

То, что эти фильтры действуют как на объекты, так и на растровые 

изображения, составляет очень ценную особенность Adobe Illustrator. Она 

позволяет легко изменять цветовую модель и цветовой баланс всей 

иллюстрации, не требуя перехода в специализированную программу 

редактирования изображений и подгонки результатов коррекции в ней и в 

Adobe Illustrator. Еще более упрощает задачу цветовой коррекции совокупности 

объектов и изображений то, что оба типа поддерживаются инструментом 

Eyedropper (Пипетка). Им вы можете брать образцы цвета как с векторных 

объектов Illustrator, так и с импортированных растровых изображений. При 

этом инструмент анализирует не цвет пикселов экрана, а их значения, 

содержащиеся в файле изображения. Растеризация объектов. Растровые 

объекты могут попасть в иллюстрацию не только из внешних файлов, но и быть 

созданы непосредственно из векторных объектов Illustrator. Для выполнения 

этой задачи существует специальная команда Rasterize (Растрировать) из меню 

Object (Объект). Она открывает диалоговое окно, изображенное на рис. 9.14. 

Команда выполняется для всех объектов, выделенных на странице 

иллюстрации. Для растеризуемого объекта вы можете выбрать цветовую 

модель (RGB, CMYK, Grayscale (Градации серого) или Bitmap (Битовый)), 

разрешение (72, 150, 300 или любое другое) и режим сглаживания (Anti-Alias). 
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Флажок Create Mask (Создать маску) задает режим создания обтравочного 

контура вокруг растеризуемого объекта или нескольких объектов. Обтравочные 

контуры в Adobe Illustrator являются частным случаем масок. О масках и их 

использовании подробно рассказывается в следующем уроке. В результате 

растеризации оригинальный объект удаляется, а вместо него появляется 

растровое изображение. Оно рассматривается как внедренное и входит в список 

изображений в палитре Links (Связи). Растеризация объектов используется 

преимущественно для создания специфических эффектов, выполняемых 

художественными фильтрами. Посмотрим, что можно сделать с их помощью. 

Растровые фильтры 

Комплект поставки Adobe Illustrator включает множество 

художественных фильтров, ранее выпускавшихся отдельно под названием 

Aldus/Adobe Effects Gallery. Они также входят в комплект поставки Adobe 

Photoshop, начиная с версии 4.0. Все фильтры набора имеют одинаковый 

интерфейс (рис. 9.15), состоящий из области предварительного просмотра и 

набора ползунков и списков, задающих параметры эффектов. 

Художественные фильтры 

Все художественные фильтры (группа Artistic (Имитация)) снижают 

деталировку изображения и превращают фотографию в подобие рисунка. Вы 

можете воздействовать на характер искажения, применяя разные фильтры, и на 

степень искажения, увеличивая или уменьшая величины в диалоговых окнах. 

Большинство фильтров имеют такие параметры, как величина кисти (толщина 

образующихся штрихов), деталировка (чем она выше, тем более проработан 

будет рисунок) и текстура (увеличение этого параметра добавляет хаотические 

мазки в разных частях изображения). 
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Colored Pencil (Цветные карандаши). Добавляет в изображение 

штриховые перекрещивающиеся линии. Большие равномерно окрашенные 

области этот фильтр заливает оттенком серого, черным или белым цветом - 

тоном бумаги (он устанавливается на шкале Paper Brightness (Яркость бумаги)). 

Чем меньше значение на шкале Pencil Width (Толщина) и чем выше параметр 

Stroke Pressure (Нажим), тем больше линий на рисунке и тем более он 

"проработан". Этот фильтр не меняет цвет изображения (рис. 9.16).  

Cutout (Аппликация). Превращает фото в аппликацию из цветной бумаги. 

Значение шкалы No. of Levels (Число уровней) определяет число цветовых 

уровней - чем это значение меньше, тем меньше разных цветов бумаги 

задействовано. Шкалы Edge Simplicity (Простота краев) и Edge Fidelity 

(Четкость краев) предназначены определять аккуратность и подробность 

проработки изображения. Чем меньше значение шкалы Edge Simplicity 

(Простота краев) и больше значение шкалы Edge Fidelity (Четкость краев), тем 

меньше искажения. Яркость изображения не меняется. 

 
        Film Grain (Зернистость фотопленки). Результат действия фильтра - 

имитация увеличенного зерна на фотографии. На контрастных изображениях 

он может давать интересный эффект. Шкала Grain (Размер зерна) управляет, 

как вы, наверное, догадались, размером зерна, Highlight Area (Область светов) - 

процентом осветленных участков, а Intensity (Четкость) - экспозицией, то есть 

освещенностью. Изображение в результате действия фильтра обычно 

становится светлее. Fresco. Этот фильтр снабжает контуры объектов грубыми 

темными линиями. Изображение становится темнее Neon Glow (Неоновый 

свет). Превращает изображение в монохромный негатив и добавляет светлую 

обводку, "свечение", по контуру объектов. Можно управлять цветом свечения 

(Glow Color (Цвет)), его интенсивностью (Glow Brightness (Яркость)) и 

толщиной (Glow Size (Область)). Этот фильтр применяется редко, в основном к 

пейзажным фотографиям или, скажем, для имитации светящейся рекламы. 

          Paint Daubs (Масляная живопись). Придает изображению вид картины, 

выполненной маслом (рис. 9.21). Вы можете выбрать тип кисти (Brush Type 

(Кисть)), ее размер (Brush Size (Размер мазка)) и степень жесткости краев кисти 

(Sharpness (Резкость)). 
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Palette Knife (Шпатель). Этот фильтр позволяет имитировать технику масляной 

живописи, выполняемой специальным инструментом типа широкого ножа 

(мастихином). Изображение приобретает подчеркнуто грубые формы (рис. 

9.22). 

 
          Plastic Wrap (Целлофановая упаковка). На изображение словно надевается 

полиэтиленовый пакет. Темные области приобретают серый тон, светлые - 

блики. Не советуем применять к портретам, очень страшно! 

          Poster Edges (Очерченные края). Этот фильтр находит все контуры 

изображения и обводит их черными линиями. Результатом является плакат. 

Управление фильтром очень простое. Вы задаете толщину и интенсивность 

черной обводки в шкалах Edge Thickness (Толщина краев) и Edge Intensity 

(Интенсивность) и степень упрощения цветового решения изображения в шкале 

Posterization (Постеризация). При минимальном значении шкалы Posterization 

(Постеризация) вы получите двух-трехкрасочный плакат, при максимальном - 

практически первоначальную фотографию, обведенную черными линиями (рис. 

9.23). 

Rough Pastels (Пастель). Использование этого фильтра дает убедительный 

эффект пастели (рис. 9.24). В верхней части диалогового окна задаются длина 

штриха и степень деталировки. В нижней части вы определяете свойства 

материала, на который нанесен рисунок. Можно выбрать текстуру материала 

(как в окне фильтра Texturizer (Текстуризатор)), размер ячейки текстуры, 

рельефность и направление света. 

 
Фильтры штриховки Эти фильтры также создают качественную имитацию 

рисунка разными инструментами и находятся в подменю Brush Strokes 

(Штрихи) меню Filter (Фильтр): 

         Accented Edges (Акцент на краях). При небольших значениях параметров 

этот фильтр увеличивает контраст контуров (рис. 9.25). Могут быть выбраны 

ширина контуров (Edge Width (Ширина краев)), яркость (Edge Brightness 

(Яркость краев)) и мягкость контурной обводки (Edge Smoothness (Смягчение)). 

Angled Strokes (Наклонные штрихи), Crosshatch (Перекрестные штрихи). Эти 

фильтры создают эффект, похожий на действие фильтра Colored Pencil 

(Цветные карандаши), с той разницей, что большие области заливки сохраняют 
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цвет, а не заменяются цветом бумаги. Angled Strokes (Наклонные штрихи), 

Crosshatch (Перекрестные штрихи) 

 

 
 

Этапы выполнения задания. Работа с растровыми изображениями. В этом 

примере мы займемся созданием несложного рекламного плаката 

телекоммуникационной компании на основе фотографических изображений. 

Плакат исключительно прост, но требует применения большинства приемов 

работы с изображениями. В плакате используются всего две фотографии, 

взятые нами с дистрибутивного компакт-диска Adobe Illustrator 8.0. Вы можете 

найти их, пролистывая каталог рисунков и фотографий в программе Extensis 

Portfolio или непосредственно в папке \Clip Art & Images\Stock 

Photography\Adobe Image Library\Images\ под именами SFB08.JPG и 

SCI007.JPG.  

На первом рисунке изображен человек, разговаривающий по телефону, а 

на втором - три циферблата на красивом текстурном фоне. Обе фотографии 

хорошо подходят к лозунгу компании: "Telecom - не теряйте время".  

Изобразительная идея плаката состоит в том, чтобы поместить 

обтравленную фигуру звонящего на фоне циферблатов и разместить на 

монтаже лозунг.  

Часть описанной ниже работы не может быть выполнена средствами 

Illustrator и потребует использования программы обработки растровых 

изображений. Мы использовали для этой цели Adobe Photoshop, но вы можете 

обратиться и к другим программам, например Corel PhotoPaint, JASC PaintShop 

Pro или аналогичным. 

1. Создайте в Adobe Illustrator новый документ формата 210x279 мм. 

2. С помощью команды Place (Поместить) из меню File (Файл) разместите в 

документе изображение из файла SCI007.JPG. Чтобы при последующем 

открытии документа не приходилось вставлять компакт-диск, установите 
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флажок Link (Связь). Изображение будет внедрено в файл иллюстрации при 

сохранении его на жесткий диск.  

3. С помощью инструментов Scale (Размер) или Free Transform (Свободное 

трансформирование) (а лучше всего - с помощью палитры  

Transform (Трансформирование)) увеличьте размер изображения до размера 

страницы (рис. 9.42).   

Откройте файл SFB08.JPG в вашей любимой программе обработки растровых 

изображений.  

Фоновое изображение размещено в документе Adobe Illustrator Обтравочный 

контур вокруг фигуры человека создан в Adobe Photoshop  

  
Создайте обтравочный контур для фигуры человека с телефоном. 

4. Сохраните на жестком диске полученное изображение с обтравочным 

контуром в формате EPS под тем же именем.  

5. Перейдите к Adobe Illustrator, создайте в текущем документе новый 

слой и активизируйте его.  

6. С помощью команды Place (Поместить) из меню File (Файл) разместите в 

документе изображение из сохраненного на жестком диске файла SFB08.EPS. В 

диалоговом окне Place (Поместить) установите флажок Link (Связь). 

Изображение будет внедрено в файл иллюстрации при сохранении его на 

жесткий диск. Этим вы получите возможность редактирования как самого 

изображения, так и его обтравочного контура.  

7.  Разместите изображение в левом нижнем углу страницы.  

С помощью инструментов Scale (Размер) или Free Transform (Свободное 

трансформирование) (а лучше всего - с помощью палитры Transform 

(Трансформирование)) увеличьте размер изображения так, чтобы по 

горизонтали он был равен ширине страницы. Выберите инструмент Type 

(Текст) и шрифт с засечками размером примерно 36 пунктов в палитре 

Character (Символ). Введите текст "НЕ ТЕРЯЙТЕ ВРЕМЯ" в две строки. 

Выроывняйте их по правому краю с помощью палитры Paragraph (Абзац) 

  
Придайте введенному тексту желтую заливку.  
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8. Создайте в документе новый слой. На нем мы разместим название 

фирмы.  

9. Выберите инструмент Type (Текст) и жирный рубленый шрифт 85 

пунктов в палитре Character (Символ).  

10. Создайте текст "TELECOM".  

11. Поверните текст вертикально, введя угол поворота 90? в палитре 

Transform (Трансформирование). Текст будет выглядеть эффектнее, если 

придать ему "мягкую" тень. Но как это сделать? Adobe Illustrator не позволяет 

создавать полупрозрачных объектов, а без этого тень никак не будет выглядеть 

реалистично! Мы решим эту проблему, создав тень на основе монохромного 

растрового изображения. Вспомните, ведь белые пикселы монохромных 

изображений Illustrator считает прозрачными. Размер тени должен точно 

совпадать с размером текста. Проще всего экспортировать текст в виде 

полутонового растрового изображения. 

o Придайте тексту черную заливку, если он окрашен в другой цвет. 

o Adobe Illustrator не может экспортировать только выделенный объект - 

экспортируются все видимые объекты документа. Сделаем текст единственным 

видимым объектом. Отключите видимость всех слоев, за исключением 

текущего.  

o Выберите команду Export (Экспортировать) из меню File (Файл).  

o Выберите удобное для вас имя файла, формат экспорта TIFF и щелкните 

на кнопке Save (Сохранить).  

o В диалоговом окне TIFF Options (TIFF: Параметры) выберите тип 

Grayscale (Градации серого) в списке Color Model (Цвета), разрешение High 

(Высокое), отключите Anti-Аlias (Сглаживание) и щелкните на кнопке OK (Да).  

o Перейдите в окно программы редактирования растровых изображений и 

откройте в ней экспортированный файл.  

o Увеличьте размер изображения, добавив немного места сверху и снизу, 

чтобы символы текста не касались краев изображения. В Adobe Photoshop это 

делается командой Canvas Size (Размер холста). Ни в коем случае не 

масштабируйте документ!  

o Размойте резкость изображения для имитации тени. В Photoshop проще 

всего применить фильтр Gaussian Blur (Размытие по Гауссу).  

o Переведите полутоновое изображение в монохромное с помощью 

диффузионного растрирования. Диффузный растр лучше создает эффект тени, 

чем регулярный.  Сохраните модифицированное изображение в тот же файл 

командой Save (Сохранить) в вашей программе. Перейдите в окно Adobe 

Illustrator и поместите полученное монохромное изображение на текущий слой. 

Переместите его ниже текста командой Send Backwards (Сдвинуть назад).  

Разместите изображение, имитирующее тень, чуть правее и выше текста. 
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           Тень готова, осталось только придать тексту градиентную заливку. Перед 

этим придется преобразовать текст в кривые, поскольку иначе Illustrator не 

позволит этого сделать. Переведите текст "TELECOM" в кривые командой 

Create Outlines (Преобразовать в контуры) из меню Type (Текст). Сгруппируйте 

образовавшиеся контуры командой Group из меню Object (Объект), чтобы с 

ними было удобно работать, как с единым целым. Придайте тексту 

градиентную заливку Chrome, выбрав ее образец в палитре Swatches (Каталог).  

Чтобы выделить главного героя плаката, применим к его изображению 

художественный фильтр Fresco (Фреска). Выделите обтравленное изображение 

инструментом Selection (Выделение). Выберите фильтр Fresco (Фреска) из 

группы Artistic (Имитация). Готовый плакат 

 
 

Раздел 7. ПЕЧАТЬ. ОПТИМИЗАЦИЯ РАБОТЫ. ГРАФИКА ДЛЯ WEB. 

Практическая работа 7.1.  

Разработка дизайна для web-сайта  

Норма времени: 10 часов 

Цель работы: Разработать дизайн для web-сайта, познакомиться с 

понятием контента сайта, изучить основные необходимые разделы носителя, 

познакомиться с основными законами линейной перспективы. Научиться 

изображать объекты в соответствии с зрительным восприятием видимых форм 

в пространстве, используя знания основных приемов линейной перспективы. 

Студент должен знать: 

Приемы растрирования. 

Треппинг и наложение. 

Параметры управления цветом. Цветоделение. 

Понятие оптимизация ресурсов. 

Подключаемые модули. 
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Макрокоманды. Размер страницы. Способы оптимизации 

Студент должен уметь: 

Разрабатывать web-дизайн, согласно современным требованиям и течениям на 

рынке web-пространства. Записывать и запускать макрокоманды. 

Подготавливать иллюстрации для Web-страницы. Представления объектов и 

графика для Web. Создавать «живые фигуры». Создавать  эффекты тени и 

свечения. Оптимизировать изображения для Illustrator. 

Задание: Разработать дизайн для web-сайта (главная страница), согласно 

современным требованиям и течениям на рынке web-пространства. 

Методические рекомендации по выполнению работы: Страница (сайт) не 

должна представлять из себя супер-графического изыска, который весит сотни 

килобайт, т.к. это жестоко, ни одна живая душа не выдержит подобной пытки 

(грузить долго)  

1) - параметр vspace - задает расстояние между текстом и рисунком (по 

вертикали). Расстояние задается в пикселях (pixel - минимальная единица 

изображения, точка. Например разрешение экрана 800х600 - 800 на 600 точек). 

В нашем примере расстояние равно 10 пикселям.  

(2) - параметр hspace - тоже задает расстояние между текстом и рисунком, 

но по горизонтали. Расстояние задается в пикселях. В нашем примере оно 

равно 30 пикселям (точкам).  

(3) - параметр alt - краткое описание картинки. Если навести курсором 

мыши на рисунок, и так подержать его (курсор) несколько секунд выскочит 

описание картинки. В нашем случае это будет фраза - "моя фотография". Если 

параметр alt не задавать, описания не будет. Но умные люди говорят, что 

описание картинкам задавать следует (особенно, если это кнопки), т.к. есть 

особенные люди, которые бродят по интернету с отключенной графикой. Без alt 

им не будет видно на что жать, т.к. картинка не отображается, а при заданном 

alt, можно увидеть надпись, для чего она (картинка) предназначалась.  

(4) - параметр width - ширина самой картинки (в пикселях). Если ширину 

не задавать специально, то по умолчанию она будет равна реальной ширине 

картинки (а так вы можете ее сделать или уже или шире).  

(5) - параметр height - высота самой картинки (тоже в пикселях). Так же 

как в случае с width высоту (height) картинки можно и не задавать. Правда, 

умные люди говорят, что размеры картинок следует задавать, для тех же 

особенных людей с отключенной графикой. 

(6) - параметр border - рамка вокруг самой картинки (в пикселях). Можно 

не задавать.  Все параметры могут употребляться одновременно друг с другом, 

чтобы избежать путаницы продемонстрирую наглядно на нашей страничке.  

Страничка может состоять из нескольких документов. Один из них 

главный (index.html или main.html) - он открывается первым и должен 

обязательно лежать на вашем сайте в интернете.  Остальные документы вы 

можете называть как угодно (photos.html, about_me.html, my_pets.html, 

friends.html, gh516hgd.html). Они все могут лежать в одной директории (папке), 

а могут в разных. Ссылкой на эти другие документы (части нашей страники) 

может быть текст (фраза, слово), а может быть и картинка. На этой ступеньке 
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мы рассмотрим только текстовую ссылку.Html не является языком 

программирования, он предназначен для разметки текстовых документов (т.е. 

для форматирования текста). То, как будет выглядеть ваш текст, определяют 

метки (tags или тэг). Попробуйте между тэгами Body - посмотрите, что 

получится. Т.е. все, что находится между < и > - это тэг. Текст, не находящийся 

между такими скобками < > - весь виден при просмотре в броузере. Некоторые 

тэги, вроде <br>, не требуют закрывающего тэга. Все тэги, расположенные 

между <head> </head>, это что-то вроде служебной информации (наша служба 

и опасна и трудна, и на первый взгляд как- будто не видна:). Например <title> - 

заголовок. Откройте IE (Internet Explore) с нашим документом и устремите свой 

взгляд выше всех командных строк (на заголовок окна). Все тэги, 

расположенные между <body> </body> - непосредственное содержание 

документа. Текст в документе, если не задавать параграфы, всегда 

выравнивается по умолчанию по левому краю. Существуют шесть уровней 

заголовков, и то, что соответственно буковки у каждого разного размера, и то, 

что тут у нас такая же ситуация как с параграфами (принудительный перенос 

строки). Точная наука, которая учит нас изображать на плоскости предметы 

видимого мира в соответствии с кажущимися изменениями их величины, 

очертаний и четкости, обусловленных степенью отдаленности от точки 

наблюдения. Пропорции – соразмерность, определенное соотношение частей 

между собой. 

Этапы выполнения задания: 

Согласно ранее пройденного 

материала, разработать макет страница 

сайта по образцу. 

Работа ведется с использованием 

программ Adobe Illustrator и Adobe 

Photoshop. 
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Рекомендации по выбору нужного формата файлов 

Необходимо подробно рассмотреть форматы графических файлов, для того, 

чтобы уметь выбрать нужный формат при сохранении и знать какие форматы 

включают алгоритм сжатия без потерь качества, какие приводят к необратимой  

потере части информации.  

Сравнительная характеристика 

 Растровое  

изображение 

Векторное 

изображение 

 

Трехмерное 

изображе- 

ние 

Фракталь 

ное- 

изображение 

Кодирование 

изображе-

ний: 

составляется из 

мельчайших  

точек 

пикселов) – 

цветных 

квадратиков 

одинакового 

размера. 

состоит из 

контуров 

элементов 

(прямых, 

кривых линий, 

геометрических 

фигур), которые 

могут быть 

залиты цветом 

 

состоит из 

контуров 

элементов 

Базовым 

элементом 

является 

сама 

математичес

кая формула, 

хранится 

изображение 

и строится 

по 

уравнениям.  

Применение для обработки 

изображений, 

требующей 

высокой 

точности 

передачи 

оттенков 

цветов и 

плавного 

перетекания 

полутонов.  

Например,  

для: 

ретуширо- 

вания, 

реставриро- 

вания 

фотографий; 

создания и 

обработки 

фотомонтажа, 

коллажей; 

применения к 

изображениям 

различных 

для создания 

вывесок, 

этикеток, 

логотипов, 

эмблем и пр. 

символьных 

изображений; 

для построения 

чертежей, 

диаграмм, 

графиков, схем; 

для рисованных 

изображений с 

четкими 

контурами, не 

обладающих 

большим 

спектром 

оттенков 

цветов; 

для 

моделирования 

объектов 

изображения; 

для создания 

в архитек-

туре,  

в рекламе 

видеоролика

х, 

 изделиях 

машинострое

ния 

изображе-

ния 

моделируютс

я  и 

перемещают

ся в 

простран-

стве 

научные 

расчеты,  

инженерное 

проектирова

ние,  

компьюте-

рное 

моделирован

ие 

В матема- 

тике,  

Изобразител

ь-ном 

искусстве  

 



 82 

спецэффектов; 

после 

сканирования 

изображения  

получаются в 

растровом виде 

 

 3-х мерных 

изображений;  

физических 

объектов  

изделия в 

машинострое

нии, 

Масштабиро-

вание 

Масштаби- 

руется с 

потерей 

качества 

масштабируется 

без потери 

качества 

Масштаби-

руется без 

потери 

качества 

масштабируе

тся без 

потери 

качества 

Реалистич-

ность  

 

реалистичны, 

обладают 

высокой 

точностью 

передачи 

градаций 

цветов и 

полутонов 

более 

схематичны, 

менее 

реалистичны 

 

более 

схематичны 

реалистичны 

 

Програм-

мные 

продукты 

 Paint 

Microsoft Photo 

Editor 

Adobe Photo 

Shop 

Fractal Design 

Painter 

Micrografx 

Picture 

Publisher  

Corel Draw 

Adobe Illustrator 

Fractal Design 

Expression  

Macromedia 

Freehand  

AutoCAD  

RMRDraw 

 

3DStudio 

MAX 5 

AutoCAD 

Компас 

ArhiCad  

Blackdown 

Java3D 

ALIAS 

WAVEFRON

T MAYA 5.0 

GraphiSoft 

ArchiCAD 

8.1 

Фрактальная 

вселенная 4.0 

Fracplanet 

The Fractory 

 

 

Аналоги близкими 

аналогами 

являются 

живопись, 

фотография 

близкими 

аналогами 

являются 

слайды 

мультфильмов, 

представление 

математичес- 

ких функций на 

графике 

Графика в 

компьютерн

ых играх. 

близкими 

аналогами 

являются 

снежинка, 

кристалл 

Форматы BMP-Windows 

Bitmap 

TIF-Tagged 

Image File 

VMF- Windows 

Metafile EMF  - 

Windows 

Enhanced 

 POV-Ray 
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Format 

PCX- PC 

Paintbrush 

PSD - 

Photoshop 

PCT-Macintosh 

P1CT 

GIF-

CompuServe 

GIF 

PCD-Kodak 

Photo CD 

TGA-True 

Vision Targa 

DIB-Windows 

DIB 

PMG-Portable 

Network 

Graphics 

JPEG - JPEG 

Metafile 

CGM - Computer 

Graphics 

Metafile 

EPS- 

Encapsulated 

PostScript 

DRW - 

Micrografx 

Desiner/Draw 

DXF- 

AutoCadformat 

2-OT 

CDR  - 

CorelDraw 

WPG - 

DrawPerfect 

PIC - Lotus 1-2-3 

Graphics 

HGL - HP 

Graphics 

Language 




